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1 General Information
This manual must be read prior to operating the scanner.
The Bioptonics OPT Scanner 3001M should only be used for research.

The Bioptonics OPT Scanner 3001M uses Optical Projection Tomography (OPT) to produce 2D &
3D images of small biological specimens.

When reading this manual -

Pay particular attention to safety advice, labelled with this warning symbol.

Useful information, explanations and recommendations are labelled with this
symbol.

/N

The scanner must only be operated by skilled personnel. It may pose a hazard if it is not used for
its intended purpose or used by untrained personnel.

Caution symbol A is displayed on the 3001M Scanner; refer to manual for details on
potential hazards and actions to be taken.

Do not remove cover. It is hazardous to operate scanner with cover removed. It could result in
exposure to UV light or electric shock.

Removal of cover (apart from opening of hatch to replace UV lamp unit — see Appendix 10) or
damage caused by misuse will invalidate warranty.

Repairs must be carried out by qualified personnel. See Appendix 10.
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2 Compliance

Bioptonics OPT Scanner 3001M complies with:

EN61010-2-81: 2002 + A1: 2003

EN61010-1: 2001

UL61010-1 second edition

CSA-C22.2 No. 61010-1 second edition

EN61326: 1997 + A1: 1998 + A2: 2001 + A3: 2003 (minimum immunity requirements only)
EN55011: 1998 + A1: 1999 + A2: 2002 (Class A Group 1 limits)

EN61000-3-2: 2000

EN61000-3-3: 1995 + A1: 2001

CFR 47 October 1, 2003. Part 15.107 and 15.109 (Class A limits)

Approved by MET Laboratories (File: E112598)

Radio Interference

Bioptonics OPT Scanner 3001M complies with limits for Class A digital devices pursuant to part
15 of FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when equipment is operated in a commercial environment. This equipment
generates uses and can radiate radio frequency energy and if not installed & used in accordance
with this instruction manual, may cause interference to radio communications. Operation of this
equipment in a residential area may cause interference, in which case the user will be required to
correct the interference at own expense.

Canadian Regulations

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital
apparatus as set out in the radio interference regulations of the Canadian Department of
Communication.

Le present appareil numerique n’emet pas de bruits radioelectriques depassant les limites

applicables aux appareils numeriques de Class A prescrites dans le reglement sur le brouillage
radioelectrique edicte par le Ministere des Communications du Canada.
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3

Safety Precautions

A\

Lifting
Four people, trained in lifting procedures, will be required to move packing case.
Weight 55kg.

Two people, trained in lifting procedures, will be required to lift Bioptonics OPT
Scanner 3001M from packing case. Weight 30kg.

A\

Electrical
Mains power should be disconnected before replacing fuses, changing focusing lens
or lamp unit.

Only fuses of same specifications should be used.
Only use power cables supplied to operate scanner. They come equipped with a 3
wire grounding plug. This plug will only fit a grounded AC outlet. Do not defeat the

purpose of this grounding plug. Use of incorrect cables will invalidate warranty.

This scanner contains High Voltage components. Only authorised and qualified
service personnel should carry out repairs.

Chemical
Observe local health & safety policy when handling hazardous chemicals.

Dispose of hazardous waste chemicals according to local regulations.

Take care not to spill chemicals in specimen chamber.

UV Light Source
Eye and skin damage may result from exposure to light produced by UV light source.

UV face shield, lab coat and gloves should be worn when UV source is being
unpacked & replaced.

Lamp unit contains mercury; therefore manage according to local regulations.

The level of UV energy produced by light source is sufficient to ignite flammable
substances. Do not leave scanner unattended when UV light is switched on.

When replacing lamp unit, allow unit to cool down completely before opening casing.
Dispose of lamp unit according to local regulations.

Lamp should only be operated in XFO X-cite lamp housing. In the rare event of
mercury lamp exploding, switch off power and evacuate all personnel from area to
prevent inhalation of mercury vapours. Ventilate area for a minimum of 30 minutes.
When cooled waste can be collected observing local health & safety policy. Dispose
of waste according to local regulations.

If lens cover is manually overridden when UV lamp is switched on, UV lamp will be
switched off automatically.

Mechanical
This machine contains moving parts. If chamber door is opened during operation
rotation stage movement will stop

Electrostatic Discharge (ESD)
In order to protect the scanner from ESD, gloves should be worn at all times.
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4 Unpacking, Installation and Repacking

Unpacking
Remove packing case from pallet. This will require four people.

Inspect case for exterior damage. Any damage should be reported to Bioptonics within 2 working
days of receipt.

BRI I TRONIC =

»
PEREE g S e S -~

Fig. 4a Packing Case

Cut off cable ties from the silver clasps.
Undo 4 silver clasps & remove lid by lifting vertically. This will require two people.

Remove cling film from scanner.

Lift Bioptonics OPT Scanner 3001M out of the case. This will require two people. Place on a flat,
level surface and ensure there is no risk of transmitted vibration, which could affect scans.

Retain case for future transportation. It is essential for fulfilment of back-to-base warranty.
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Installation

Open specimen chamber door (Fig. 4b).

Unscrew black knob anti-clockwise, pull red metal plate forward to remove (Fig. 4c).
Do not put the knob back into the scanner. Keep it separately together with fixation
bar

Fig. 4b Bioptonics OPT Scanner 3001M Scanner with Chamber Door Open

Fig. 4c Specimen Chamber with FixationBar in Place

& The scanner must not be switched on or operated with the
transportation fixing device in place. If fixing device is in position during
initialization procedure major damage will occur. This will not be covered by
warranty.
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Connect firewire and serial cables from computer to scanner. The ports are on right hand side of
scanner.

Connect mains power cable.

Repacking

With computer and scanner turned on move rotation stage to raised position.

Remove quartz cell.

Install transportation fixing device.

To do this stage height will have to be lowered from maximum height in order to line up screw

holes.

When fixing device has been secured, switch off Bioptonics OPT Scanner 3001M.
Remove all cables.

Ensure any traces of BABB have been wiped up with methanol.
Two people will be required to lift scanner into packing case.
The scanner only fits into case in one orientation.

Replace lid, it only fits in one orientation.

Fasten four silver clasps.

12 version 1.10.7 10/11/08



13

This page has been left blank intentionally.

version 1.10.7

10/11/08



5 Instructions for OPT Scanning Software

This chapter explains the software controls for the OPT Scanning Software. We advise that you
familiarise yourself with these by reading through this chapter before proceeding to scan
samples. Chapter 6, Scanning Specimens, refers back to the list here e.g. to switch on UV light
refer to 5.3.

5.1 Open OPT Software

Double click on desktop to open scanning software.

5.2 Switch On & Off White Light

Use this to view coloured stains.
5.3 Switch On & Off UV Bulb

@

Bulb takes approximately 90 seconds to warm up. Use to visualize fluorescently labelled
specimens.

When switching off UV light the following window will be displayed.
SkyScan3001 X

'-\- Are you sure you wish to turn the UV lamp off?
L

Yes No |

If UV light is switched on during the cooling period the following message will be displayed.

Progress

waiting for UV lamp start, 283 sec left

5.4 Switch On & Off Infra Red Light

Use this in combination with white light to visualize coloured stains. It is especially useful for very
darkly stained specimens.
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5.5 Change Filter

<

Select filters window opens

& ' No et [sansvesson wine1R)
"GPP 4254000, 4750l P
"GPP+ &70/400en. 5150mLP
T Cy3 545/30mm, 610/

[Fiokar) Corcel |

Select GFP, GFP+ or Cy3 to move filter to correct position to view specimen.
No filter (transmission white/IR) blocks UV light. Use to prevent fading of fluorescent signal due to
unnecessary exposure to UV light.

5.6 View Live Image on Screen

-

Switches off and on live image.
5.7 Select Resolution

Left click

High resolution

v Standard resolution

512 x 512

Choose Standard 512 x 512 or High 1024 x 1024
or

Options > Image Format
Select from menu either Standard 512x512 or High 1024x1024
When selecting resolution refer to table in 5.19

AStandard resolution images are created using 2x2 binning in
hardware. This means 4 times as much light is collected per pixel for the same
exposure time. Images produced at standard resolution will have lower noise
and require a shorter exposure time than images produced at high resolution.
High resolution reconstructions will produce datasets 8 times larger than
standard resolution. This means that most analysis operations using high
resolution data sets will take longer.
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5.8 Snap Image

6
Takes a snap shot of live image.

5.9 Raise and Lower Specimen Position

Z ¥/ 0.00mm

Left click on 0.00mm.
Position and zoom window will open.

Position and Zoom £3)

-~ Position - o0
2 osition (men) | od
ot Proel se [um) : I 1303

oK Cancel |

Enter number in Position (mm) box. 45 is a good starting point.

Or

| ¥

If a value has previously been entered clicking on down arrow will lower

specimen to the same position.

Or

£y
Left click on mouse icon '~

Mouse Wheel Action Menu will open
Mouse wheel actions:

v nong
zoom
focus
position
white light
IR light

|

4 4%, mouse wheel:

=

Select Position from list, scroll mouse wheel forward and back to raise and lower specimen.
Or
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Place cursor in window and double left click; function of mouse wheel will change to next action
on the list. Continue double clicking until Position is displayed in mouse icon. Scroll mouse wheel

forward and back to raise and lower specimen.

5.10 Zoom

Q ” 6.4um

Left click on bar and drag to change zoom.

Release to apply new value.

Maximum zoom — bar dragged to the right.

Minimum zoom — bar dragged to left.

Or

Left click on mouse icon
Mouse Wheel Action Menu will open.

Mouse wheel actions:
v  none
zoom
focus
position
white light
IR light

-
45 = mouse wheel:

Select Zoom from list, scroll mouse wheel forward and back to zoom in and out.

Or

Place cursor in window and double left click; function of mouse wheel will change next action on

the list. Continue double clicking until Zoom is displayed in mouse icon.
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5.11  Set Exposure for White Light & UV Channels

CE
L=

Or

Options
Scan Settings
Scanning Settings window will open.

£ o pus| 10
Avetagng hame:|
Fictahon Sep (degl 09
o e
& neo
0 2
¢
| o Coce |

Enter value in exposure box (milliseconds)

OK: to apply this exposure.

Snap: to show your specimen at the new exposure.
To check the exposure levels see 6.11

Averaging (frames): is normally set to 1. Change as required.

Rot Step (deg): normally set to 0.9. Change as required.

Flip Image: This will rotate image 180°, (top becoming bottom). NB If this action is selected when

centring specimen, the object will move to the left not to the right!

Left click bar and drag to rotate specimen.

5.12 Change White Light Intensity

Left click on mouse icon
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Mouse Wheel Action Menu will open.

Mouse wheel actions:
v none
zoom
focus
position
white light
IR light

3
45 & mouse wheel:

Select White Light from list and scroll mouse wheel forward and back to increase and decrease
intensity. This will be displayed as a % between 0.0 and 100.

=, Wh=100.0%

or

Place cursor in window and double left click; function of mouse wheel will change to
next action on the list. Continue double clicking until White Light is displayed in mouse icon.

5.13 Change Infra Red intensity

Left click on mouse icon |~
Mouse Wheel Action Menu will open

Mouse wheel actions:
v none
zoom
focus
position
white light
IR light

4s -~ mouse wheel:

Select IR Light from list and scroll mouse wheel forward and back to increase and decrease
intensity, this will be displayed as a % between 0.0 and 100.

4=\ IR=20.5%

or

Place cursor in window and double left click; function of mouse wheel will change to next action
on the list. Continue double clicking until IR Light is displayed in mouse icon.
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5.14 Rotate Specimen

& =|f 39.60

Left click on bar drag and release.

5.15 Focus

Left click on mouse icon '~
Mouse Wheel Action Menu will open:

Mouse wheel actions:
v none
zoom
focus
position
white light
IR light

4s .= mouse wheel:

Select Focus from list, scroll mouse wheel forward and back to focus specimen.

Or

Place cursor in window and double left click; function of mouse wheel will change to next action
on the list. Continue double clicking until Focus is displayed in mouse icon. Scroll mouse wheel
forward and back to focus specimen.

5.16  Object Centering

+ «
<

Object Centering and Rotation Window opens:

- | wn| - | s vi00f

>, >> and >>> move specimen to the right.

> very slightly, >> more, >>> even more.

The distance moved can vary depending on the position of mount on rotation stage.

I< returns pusher to home position.

If pusher is over or under responsive, change the pusher offset value in Scanner Settings
window. (See Appendix 10)

- rotates specimen anticlockwise.

+ rotates specimen clockwise.

+90 turns specimen 90°.

+180 turns specimen 180°.
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Spin rotates specimen continually, click on spin again to stop rotation.
Rotate specimen to required view, e.g. for embryo, to sagittal orientation.

If specimen is to the right of centre of axis (green line):

Fig. 5a Specimen to right of centre of axis

Rotate 180°

ARemember you can only move specimen to the right,
unless ‘flip image’ is selected in Scanning Settings then specimen will move to
the left.

Specimen will now be left of centre of axis.

Fig. 5b Specimen to left of centre of axis

Use > buttons to move until centre of axis is through centre of specimen.
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Fig. 5¢c Specimen Centred Sagittal View

Rotate 180°. Centre of axis should running through centre of specimen. If not adjust by repeating
procedure above. It may take a few rounds of rotating 180° and moving specimen in order to align
it.

Turn specimen 90° e.g. to frontal plane for an embryo and repeat alignment procedure as above.

Fig. 5d Specimen centred. Frontal view
Make a final check of original plane by rotating specimen 90° then 180°.

When happy with axis of rotation click spin to confirm. Specimen should be rotating on its centre
of axis (not moving across the window from side to side).

Click OK.
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5.17  Acquire Flat-fields

Options > FlatField References > Acquire Dark or Acquire Bright

SCanning Setings..
Loht and Fiters »
Image Format »

Apply Flat-field coerection
SCarmer Setlp,,
Abgrment
Preferences..,
About OPT program...

When acquiring a flat-field on a fluorescent channel, Acquire Bright will be greyed out.

When acquiring flat-field on white light, Acquire Dark will be greyed out.

Alt may not look like anything has happened!

Especially if exposure time is very short.

5.18 Scanning Multiple Channels

&

Multiple Scanning Window will open

f:?; Excctune pre! Averagng Pest| . Aot ses ldegl
q WHITE - {
- Y |
GO ASnlP ) : 1 )
GFP s 470V 80ree. 515l P
OIS 0w 6107 v 2 | ! 1 09

Fllerame prele . mape

Dots Donciony - [ 'vonabe\T aef 20X

W Swstch OFF UV towsce alber scarrnyg

ox Carce

Click on use this channel boxes for required channels.

Exposure time (ms) will be the last value chosen in Scanning Settings. Change as necessary.
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Averaging (frms) is normally set to 1. Change as required.
Rot. Step (deg) normally set to 0.9. Change as required.
Channels not being used will be greyed out.

Filename Prefix this will be the prefix given to output .tif files.
Browse to make a destination folder for .tif output files.

5.19 Scanning Settings

[ B
L=
Scanning Settings window will open.
S ooy Seltmgs %)
Sxponee ) R 4

Avetagng Pame:|
Frctaon Siep [degt - |

o e T

o

[ o I Corcel

Exposure time (ms): will be the last value chosen. Change as required.

Averaging (frames): normally set to 1. Change as required.

Rotation Step (deg): normally set to 0.9 on standard and 0.45 on high resolution.
High resolution scanning requires double the number of frames to achieve the same
reconstruction sampling rate.

Resolution | Rotation Step (deg) Number of Frames Equivalent Sample Rate
Standard 0.9 400 High 0.45

Standard 0.45 800 High 0.23

High 0.45 800

High 0.23 1600

Flip Image: This will rotate image 180°, (top becoming bottom). NB If this action is selected when
centering specimen, the object will move to the left not to the right!

Snap: updates current image e.g. following change to exposure value.

¥

Left click bar and drag to rotate specimen.

&
e

If graph has been selected prior to opening the Scanning Settings window (see 6.11) this
bar will be displayed. Drag slider to move position of graph.

OK to apply new settings.

5.20 Clock

(L) estim:4m34s
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Displays estimated time left for scan in progress.
5.21 Flag

ﬁﬁ" ready

Displays Ready when a scan has finished and a new scan can be started.
% of scan completed is displayed during scan.

5.22  Start Reconstruction

Opens Nrecon software.
Refer to chapters 7& 8 for details on how to use Nrecon.

5.23 Show Results

%

Opens DataViewer software. (This function not presently available)
Refer to chapter 9 for details on how to use DataViewer.

5.24 2D/3D Analysis

Opens CT-Analyser. (This function not presently available)
Refer to Chapter 10 and CT-Analyser User Manual for details on how to use CT-Analyser

5.25 Scanner Alignment/Calibration
Options

Alignment
Misalignment analysis window will open.

Misalignment analysis

Misabgrment measurement
" for one (current) magification

* two-pont messurement

| (114 I Cancel

Select 2-point measurement, and OK.
Alignment pin will rotate through 360° at minimum and maximum zoom.

Selecting for one [current] magnification will carry out alignment at the current set zoom. This
should only be used if zoom will not change.

Alignment Results window will open on completion.
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I =

If 2-point measurement was selected, alignment values in pixels and microns will be shown at
maximum and minimum magnification.

If one magnification was selected, alignment value for set zoom in pixels and ym will be shown
Click OK

If pixel value exceeds +/- 128, do not use scanner. Contact Bioptonics, see Appendix 10

ACalibrating the scanner ensures that the axis of rotation of the
specimen stage is vertical and in the centre of the field of view. The figures
reported allow the scanner to compensate for slight misalignment due to
manufacturing, transportation or settlement.

Rotation [deg]: Measures rotation. If value exceeds 1 degree, contact Bioptonics: see Appendix
10.

Use for rotation compensation: if this is checked the program will attempt to correct for the
rotation with a reduction in image quality. In normal use do not select this option.
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Other Software Controls and Options

Action Drop Down Menu
Alternative ways to start actions along top tool bar.

s L

Snap Image
QDject cenmterng....
Start Scanning

Start Muitpee Scanning

Start Recorstructon
Show Results

2D /30 Image Analyss

Qpen 1mage. .. Crl4Q
Save Image.., Crles
Primt »
Exit

Grab Image — Switches TV mode off and on.

Snap image — Takes a snap shot of live image.

Object Centering — Opens Object Centering window. See 5.16.

Start Scanning - Opens Scanning Settings Window. See 5.11.

Start Multiple Scanning — Opens Multiple Scanning Window. See 5.18.

Start Reconstruction — Opens Nrecon Software. See chapters 7 & 8 for details on how to use
Nrecon

Show Results — Opens DataViewer Software (not activated). See chapter 9 for details on how to
use DataViewer.

2D/3D Analysis — Opens CT-Analyser (not activated). See Chapter 10 and separate CT-
Analyser User Manual for details on how to use CT-Analyser

Open Image — Allows you to browse and open previous images saved.

Save image — Allows you to save current image as a .bmp or .tif file.

Print — Displays printer options.

Exit — Closes OPT software
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Options Drop Down Menu.

Scanning Settings...
Ught ang Fiters >
Image Format 4

Apply Flat-fiedd correction
FlatField References »
Scanner Setlp...

Algnment

Preferences...
About OPT program...

Scanning Settings — Opens Scanning Settings Window.

Lights and Filters — Opens dropdown menu containing options to switch off and on light sources
or change filter.

Image Format — Allows you to select either standard 512 x 512 or high resolution 1024 x 1024.
See 5.7.

Apply Flat-field correction — Checks off and on Flat-field correction to live image.
FlatField References — Acquires bright and dark. See 5.17.

Scanner SetUp — Opens:

Cowrm SN L]

Seipont  COM

Frodd of vaons Joen) [ 208
Image shaton Meg) B
Pusher oioct o | 23

Focus

Backiash |degl

Accouacy syl v

" OFF st sbgrinent Compeneston

Scanner S/N — Scanner serial number.
Serial Port COM — The number of the serial port to which the scanner is attached.

Field of View (mm) — Microscope field of view at minimum magnification. This should not have to
be changed.

Image Rotation [deg] — The correction factor for the microscope alignment. This parameter is
set automatically when performing the alignment procedure.
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Pusher Offset (mm) — The correction factor controlling the alignment of the pusher. If the pusher
becomes unresponsive this value should be increased in units of 0.1mm. If the pusher is over
responsive this value should be decreased in units of 0.1mm. Refer to Appendix 10 for detailed
instructions.

Focus Backlash — Corrects for the backlash of the focus motor. Do not change this value.
Focus Accuracy — Increasing this will decrease the amount the focus is changed with every
movement of the mouse wheel. This has the effect of increasing the focus sensitivity. Set this to
user preference.

OFF Misalignment Compensation — Selecting this causes the software to show the output of
the camera without the misalignment correction applied from the alignment procedure. In normal
use this option should not be selected

Alignment — Opens Misalignment Analysis Window see 5.25.

About OPT Program — Information on program and contact details for Bioptonics.

Preferences — Opens:

v Fetcale mage: o W scoeen

W Sourd nobicators
Doty alber rotabondm ) | T0C
)8 erd et

0

D oty (RS T}

UV g 1500, s

:"-«

Rescale images to full screen — Increases size of viewing window to full size.

Sound notifications — When this option is selected the software will play sound effects to inform
user of certain events e.g. when a scan finishes.

Delay after rotation [ms] — Adds a time delay after each frame taken during the scan. This may
be necessary if scanning large specimens embedded in 1% agarose. Adding a delay will remove
any wobble seen in the original projection image. Default is 500ms. Enabling this will increase
scan time.

Image enhancement — This option applies a correction for the modulation transfer function of the
lens. It is set to the optimal value but may be changed by the user.

UV lamp — Use reset button to reset counter after replacing lamp unit.
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Error Message - If a mechanical movement is interrupted by the chamber door being opened,
e.g. zoom or stage position the following window will be displayed. It is advisable to restart the
software.

SkyScan3001

' Opening specimen chamber door interrupted one of the movements.
[ Recomendation: restart scannmer control software.,
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6 Scanning Specimens

This chapter explains the specimen scanning procedure. Before scanning you must prepare
quartz cell (see 6.1). The scanner must be aligned/calibrated at the start of each days scanning
(see 6.2). Scanning procedure is outlined in 6.3 onwards.

Before any scanning can be performed specimen will have to be embedded, dehydrated and
cleared in BABB. See Appendix 1 for protocol. (5.1) etc. refers to Chapter 5 Instructions for OPT
Scanning Software.

6.1 Set up

Quartz cell should be cleaned with methanol, inside & outside. Use lens tissue, or similar to
remove all dust particles.

Allow methanol to evaporate before filling with BABB.

Maximum fill level is 10 mm from top of Quartz Cell. If large specimens are to be scanned, less
BABB may be required, due to displacement. (See Appendix 1 for BABB recipe).

Handle quartz cell on frosted sides only.

Place quartz cell into base frosted side closest to you.

The BABB in the quartz cell only requires changing as required e.g. when contaminated with
debris.

ABABB should be treated with care. Wear appropriate gloves, goggles
& laboratory coat when handling. Refer to local health and safety policy.
Small splashes should be wiped up immediately with methanol.

For LARGE spills switch off power immediately, and disconnect power cable.
Absorb with tissue and wipe up residue with methanol.

Contact Bioptonics immediately and do not use scanner again until advised to
do so by Bioptonics.

Dispose of waste according to local regulations.

6.2 Alignment/Calibration of Bioptonics OPT Scanner 3001M
Alignment should be carried out at the beginning of each day of scanning.

Switch on Bioptonics OPT Scanner 3001M. Power switch is green button on right hand side of
scanner. Switch on Dell computer.

Open OPT scanning software (5.1).
White light will be switched on automatically. If not required switch off. (5.2).

Open specimen chamber door by lifting right hand section of scanner vertically.

Attach alignment pin onto rotation stage see Fig 6a. Move pin to centre of rotation stage.
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Fig. 6a Alignment Pin attached to rotation stage
Use stubb tweezers when handling alignment pin. (See Appendix 8 for details)

Close door.

Lower alignment pin (5.9)

Select resolution to be used for scans (5.7)

Set white light to 100% (5.12)

Set exposure to 15ms (5.11)

Set zoom to maximum (5.10)

Select Object Centering (5.16). This is to check that pin is visible in window before alignment is
carried out.

Select spin from Object Centering and Rotation Window. If pin is within the window for a full 360°
rotation close window and continue.

If pin rotates out of window, stop when to left hand side of green line, move to a more central
position using > controls. Pin does not have to be centred on green line only visible in window for
full 360° rotation.

Carry out pin alignment (5.25)

Raise alignment pin (5.9)

Remove pin from rotation stage.

Wash with methanol to remove BABB.

6.3 Specimen Scanning Procedure

It is vital that agarose plug is securely attached to mount. Remove mount from BABB. Gently

push agarose plug sideways using blunt instrument.

If agarose plug moves it will have to be reattached. See Appendix 2.

Alf agarose plug is not securely attached to mount when specimen is
scanned there will be movement of specimen. It will be impossible to align
data accurately and inferior reconstruction(s) will be produced.
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Wipe mount & rotation stage with methanol to ensure both surfaces are clean and BABB free.

ADM or debris attached to either the mount or the rotation stage can
result in irregular movement of the mount during the scanning procedure.

Attach mount to rotation stage. Centre mount on rotation stage by eye.

Fig. 6b Mount attached to rotation stage

Close door.

ATO produce the best images “flat-fields” have to be acquired.
These are background images which are taken for each channel. When the
flat-field image is subtracted from scan image the background will be uniform
black or white, depending on channel. In order to acquire an accurate flat-
field, the specimen has to be roughly set up (position, alignment, focus and
exposure). Final zoom has to be chosen at this point. If it is changed later in
the procedure, flat-field should be re-acquired for each channel. The exposure
will be affected by the flat-field value, so this must be finally selected after the
flat-field has been applied.
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6.4 Setting Position and Zoom
Turn on UV light (5.3) and/or white light (5.2) as required.
Do not open chamber door while filter wheel is changing position.

UV Bulb will take 90 seconds to heat up.

&Lifespan of UV light source is 1500 hours. After 1400 hours usage a
message will be displayed reminding you to replace it. After 1500 hours the
bulb will not switch on.

A Do not open door when UV light is switched on.

If door is opened switch off UV by selecting Yes, or close door & select No

SkyScan3001 X

. Please dose specimen chamber
M during using UV light.

Switch OFF UV lamp now?
(dose speomen chamber and press No to continue)

Yes No I

Select resolution (5.7). Standard is suitable for most scans.

In Options menu
Uncheck Apply Flat-field correction.
This means flat-field acquired from previous scan will not be applied to live image.

Select channel required to view specimen:
If viewing specimen on UV channel select filter required (5.5)
If viewing using white light ensure no transmission is selected in select filters window (5.5).

Lower specimen into quartz cell (5.9).

Check Live View is on (5.6).

Zoom and position of specimen need to be set.
If specimen is not visible in window:

Reduce zoom (5.10)

And /or adjust vertical position of specimen (5.9).
Exposure may also have to be adjusted (5.11).

When specimen is visible, adjust zoom and position so that the entire specimen is visible in the
window.

6.5 Rough Exposure Setting

Adjust white light exposure and/or intensity (5.11 and 5.12) so that the entire specimen is visible
and the background is white. There should be no areas of saturation, i.e. completely “whited out”.
Switch on and adjust infra red intensity if required (5.4 and 5.13).

See in section 6.11 (coloured signal) for an explanation of when to use infra red light.

Adjust UV channels exposure (5.3 and 5.11) so that the entire specimen is visible and the
background is black. There should be no areas of saturation, i.e. completely “whited out signal”.
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6.6 Rough Specimen Alignment
When specimen is rotated (5.14), it should be roughly in the centre of the window. If not, move to
a central position (5.16).

6.7 Adjust zoom
Set zoom to required position (5.10).

AThis is the zoom which will be used in your scan. It should not be
changed after Flat-field values have been acquired. If zoom is changed, Flat-
field value should be reacquired.

6.8 Rough Specimen Focus
Focus specimen roughly on one channel (5.15).

6.9 Acquire Flat Field

AAcquiring a flat-field correction allows the user to remove background
artefacts such as dust from the image. The bright flat-field should be used with
brightfield (white light/infra red) imaging. The dark flat-field should be used
with fluorescent imaging.

Raise specimen out of quartz cell (5.9).

Select first UV channel (5.5).
Acquire Dark (5.17).

Select second UV channel if required (5.5).
Acquire Dark (5.17).

If not scanning on white light, you have finished acquiring flat-fields.
Lower specimen to position previously set (5.9)

Switch on view live image on screen (5.6)

If scanning with white light:
Select No transmission (5.5)

Switch on white light (5.1) and infra red if required (5.4)
Acquire Bright (5.17)

Lower specimen to position previously set (5.9)
Switch on view live image on screen (5.6)

Flat-field will be applied to live image.
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6.10 Specimen Alignment
Switch on white light or UV as required (5.2, 5.3).
Align specimen accurately (5.16).

A In order for reconstruction to be successful, it is important that
specimen is rotating on its centre of axis (not travelling across the window as it
rotates). This can take practice!

Embedding your specimen accurately i.e. perpendicular to mount will simplify
the alignment procedure (see Appendix 1).

6.11 Exposure Setting
Set exposure accurately (5.11, 5.12 & 5.13).

Fluorescent Signal

Place cursor over brightest area. The specimen may have to be rotated to find this.

Right click to toggle off and on the exposure graph which will be displayed over specimen. Graph
directly above brightest area of signal should be just on or slightly below upper green line.
Background should be black; line corresponding to black on graph should be on or just above
lower green line.

When graph is displayed open Scanning Settings window (5.19)

Scanevnng Sellmgs

Lxponee pu) R &
Averagng Pame:|
Fitaton Sep [degl 09

5o e |

f' o I Coce

Change exposure value and snap, the graph will update.

S

JL
Dragbar to move position of graph.

NB this option is only displayed if graph is selected prior to opening Scanning Settings Window.
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Fig. 6¢c Fluorescent specimen Over-exposed

Fig. 6d Fluorescent Specimen Under-exposed

Fig. 6e Fluorescent specimen Correct Exposure

ATO produce the highest quality reconstructions, brightest areas of
signal/interest should be just below saturation point.
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Coloured Signal
If signal is very dark use a combination of white light and infra red.

Switch on white light. Set exposure time and intensity (5.2, 5.11, 5.12).

Switch on infra red light if required. Adjust white and infra red intensity until signal is less intense
(5.4, 5.11, 5.13).

When using infra red light the exposure time should be set to a minimum of 20ms. Increasing
exposure will make camera more sensitive to the infra red light, therefore more of an effect will be
seen when increasing infra red intensity.

Place cursor over darkest area of stain. Specimen may have to be rotated to find this.

Right click to toggle off and on the exposure graph which will be displayed over specimen; an
exposure which allows you to see all signal should be chosen. This can be difficult if there is a
wide variation in signal intensity.

Ensure that the edge of specimen does not merge into white background.

Background should be white; line corresponding to white on graph should be close to or on upper
green line.

When graph is displayed open Scanning Settings window (5.19) Change exposure value as
required, the graph will update.

Scaneng Selbmgs

Lponme ) R 4
Averagng hame:|
Fitabon Siep [degt 09

o e 7

| o I Corced

Change exposure value and snap, the graph will update.

Anys —— f——

iyt
Drag bar v to move position of graph.

NB this option is only displayed if graph is selected prior to opening Scanning Settings Window.

Aln order to produce the highest quality reconstructions, stained areas
should not be too dark. Light cannot penetrate and this will adversely affect
the reconstructed data.
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Fig. 6f White Light Specimen Over-exposed
N.B. specimen whited out

Fig. 6g White Light Specimen Under-exposed
N.B. background is not white

» @0
.

-

Fig. 6h White Light Specimen Correct Exposure
N.B. Edge of specimen visible above background and all signal visible
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Fig. 6i White Light Specimen with White & Infra Red Light
N.B. Signal intensity reduced

6.12 Focus
Focus specimen (5.15).

Rotate specimen (5.14) and check focus at various positions and on different channels.

Alf specimen is difficult to focus, move completely out of focus then
refocus.

See Scanner Setup for option to change focus sensitivity.

Rotate specimen to orientation required for first frame of scan.

6.13 Scanning

Open Multiple Scanning window (5.18) or Scanning Settings (5.11) if scanning one channel only.
Select channels and enter required values for rotation and averaging. Exposure (ms) displayed

will be last value chosen (5.18).

Click Browse; navigate to required folder.

Click New and type the name of folder for storing the scan files (specimen ID folder).
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Cument doldec

C oo \0N1 205

Mave

I Cancel

During the scan, a new folder for each channel scanned will be created in specimen ID folder.
They will be named C1_WH_IR or C2_GFP etc.

Click Switch OFF UV Source after scanning if required.

A Remember it will take up to 5 minutes to switch UV source on again.

Click OK. Scanning will commence.

Estimated time to scan on present channel will be displayed next to clock (5.20)

Scanning % completed will be displayed next to flag. (5.21)

When first channel is completed, next channel will automatically begin.

When last channel is finished READY icon will be displayed (5.21)

UV light will switch off automatically, if this option was selected in Multiple Scanning Window.

Filter change will go to “no transmission” if UV light is not switched off.

Remove specimen (5.9).

A Take care not to slash BABB when removing mount. Wipe up
splashed BABB immediately with methanol.

6.14 Check Scan

See Chapter 9 for instructions on how to view scan using DataViewer.

View rotating specimen, to ensure scan was successful.

Pay particular attention to any jumps. If specimen jumps (it is usually due to agarose not being
properly attached to mount) it should be rescanned, as it may be difficult/impossible to align at the
reconstruction stage.

6.15 Post OPT
Specimens which are unstained or have signal which is stable in BABB can be stored long term
in BABB.

See Appendix 4 for protocol to remove specimen from agarose.
6.16 Mount Cleaning
Remove agarose with a blade, soak mount in ethanol or methanol. Remove any glue embedded

in grooves with forceps or similar. Clean mount with pan scourer and rinse in ethanol or
methanol. Air dry.
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7 Instructions for NRecon Software

This chapter describes how to use NRecon to reconstruct specimens scanned using the
Bioptonics Scanner 3001.

For further information on using NRecon and advanced options please refer to the software Help
files.

7.1 Start NRecon
In order to run NRecon you must first start NReconServer.exe. See 7.6

MRecon.exe

Double click
NRecon will check to establish a connection to NReconServer, see 7.6.

If NRecon and NReconServer are in the same folder, NRecon will start NReconServer
automatically. However it is advisable to start NReconServer first, see 7.6.

On opening NRecon starts with the Open Dataset dialogue:

o datinet % X

& e s =

My ansod  Flen o e TRT - Sracm wager [ ¥ - Carent

7.2 Load dataset
How to load a dataset at any time:
Actions > Open Dataset > select .tif file from required data set.
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7.3 Reconstruction Options

7.3a  Start Tab:

AT Ve Opton el

SH TP v hom A @BHOXW

z x Dao _l
W St Advecet | Dupd | Seeeany

5_'.

Top

.wuu\n; L S

o=

e s

- T Proagase
twescin ke

Fig. 7a Reconstruction Parameters

Set the top and bottom sections to be reconstructed either by dragging red lines over the
specimen, see Fig. 7a, or manually inputting the figures in the ‘Top’ and ‘Bottom’ dialogue boxes.
The ‘Step’ should always be set to one.

— and e rotate the image.

Clicking on will open Display navigation window, drag the slider to rotate the
image.

E Projection range: 0 - 400 IZSG

5
J
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Preview

Reconstructs one section, indicated by green line Fig. 7a.

Section No. is displayed in the Position box.

Results can be viewed in Output Option tab. See 7.3d.

Clicking “fastest” moves the current preview section to the fastest position. This is approximately
the middle of the specimen.

Fine tuning

Fine-tuning can be used to automate the selection of the Post Alignment value (also called
Misalignment compensation value). Rather than “trial and error” to select the most suitable value,
use Fine-tuning to process the same section with different values.

Select the parameter to process:

Ture 3 piraveter by 400 & fon Yo retoreyuitors
* Post-asigrmert (arourd 4.4)
" Beam-hardening cormection (arourd %)
Ring-o 250 redcton (wound 4)

Smodtwry) (round L)

Nuber of vl 3

P aveter sl i

o

Then set the number of trials (default=5), and the parameter step to change for each preview. For
Change Parameter step to 0.5 for the post-alignment trails.

Change the other parameter values as required.

View the results in the Output Option tab.

In the current version of NRecon the parameter referred to as Beam-hardening correction
changes the Mask threshold parameter

Add to Batch

Clicking ‘Add to Batch’ puts the current specimen and reconstruction options into the batch
manager to process multiple specimens. See 7.4 for further information. When you are happy
with the reconstruction settings, click “Add to Batch”.

Start
Reconstructs the current specimen with current settings.
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7.3b  Settings Tab:

it WENQE  Adverced  Dupas | Sunany
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Smoothing
For most OPT specimens smoothing is unnecessary so uncheck. Smoothing can obliterate fine
structure and detail in the specimen. It may be useful for specimens with little or no fine detail.

Misalignment compensation

Misalignment compensation provides a course alignment. Fine tuning is required for accurate
reconstructions. Select Fine tuning in the Start tab, see 7.3a. Misalignment compensation is
called Post Alignment in the parameter fine-tuning window.

Object larger than field of view
Check this option only when your object extends beyond FOV boundary at both sides in the
shadow image e.g. if zoomed in on specimen.

Ring Artefact Reduction

Removes rings introduced as an artefact of the reconstruction process. The value specifies the
number of neighbouring pixels to be examined for ring reduction. Generally a value of 4 is
sufficient. Increasing this will increase the reconstruction time.

If a value of greater than 4 is selected we would advise that you uncheck the box while
performing the fine-tuning, as it will slow the process down.

Defect pixel masking

This parameter is used in conjunction with ring artefact reduction to remove rings caused by dust
on the lens or camera pixel errors. It specifies a brightness threshold level for differentiating
between signal and artefact pixels. Generally a value of 50% is sufficient. If rings remain in the
output reduce this value. The minimum is 10%.

CS Rotation (in deg.):

Rotates the resulting cross-section image by a fixed angle.
See help files for further information.
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7.3c  Advanced Tab:

Sist  Setrygn Adverded Dupss | Sussary

[ Undersample

[ ] Reconstuct 180« only

Undersample
Reduces the size of the output data.

The other options are not required for OPT specimens.

7.3d  Output Tab:

S Settngs  Advanced DD Summany

| Q041100 1557000

T HU Auso

! Recorat»ct RO

| Soalectabels ON

a  Dectraton | Browne «
Z\Gwen_ 300N _Scan\ 200000
F e foenat ENFIE W
PN
JF‘ELG}
Histogram

Once a preview section has been reconstructed you can alter the output histogram. If BMP or
JPG has been selected as the file format below, two lines appear on the histogram. These lines

are used to map the floating point reconstruction produced by NRecon to the 8 or 16 bit output
files.
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The 16 bit reconstruction has 65535 grey levels while the 8 bit output has 256 grey levels. The
left hand line represents the position of the output zero line while the right hand line represents
the position of the maximum grey level line. Drag the two lines on the histogram to alter the
mapping. All of the values to the left of the left hand line will be set to 0 in the output. All of the
values to the right of the right hand line will be set to 255 in the output. See page 64 for more
information on how changing these lines affects the image.

By clicking on the box below the histogram, values for the mapping may be entered numerically.
Double click histogram window to toggle between logarithmic and linear scale vertical axis

Pressing Auto sets the histogram to its default.

If default dynamic range is selected in preferences the lower range, left hand bar or lower number
is set to 0 at first preview or when auto button is used.

In HU - This is not required for OPT.

Reconstruct ROI only

Selecting this option reconstructs only the region of interest, indicated by box (square or
rectangle) around the specimen. This is useful for removing excess black space around a
specimen, especially small specimens. However care should be taken to ensure that the ROI
selected includes the entire specimen and does not exclude any areas of the specimen.
Removing as much black space as possible makes the dataset smaller, which is particularly
useful for further processing in Bioptonics Viewer or CT-Analyser.

Scales/Labels on

Check this box to have scales and labels hard coded into your final images. In the case of
reconstructions of small ROI, you may lose some detail at the edges of the specimen where the
scales overlap the image.

Ensure this option is off if further processing in Bioptonics Viewer or CTAN is required.

Destination
Select destination for reconstruction. Browse to required folder.

File Format
Choose required output file format.

Nrecon can save files in two 8bit formats (BMP, JPG) and one 16bit format (TIF).

It is most convenient to use BMP as Bioptonics Viewer, DataViewer and CT-Analyser all support
this format.

BMP files are uncompressed, 8 bit and very large

TIF files are uncompressed, 16 bit and more efficient than BMP files.

JPG files are compressed, 8 bit and much smaller. They are made with quality set to 100% which
should mean they are visually indistinguishable from, but not numerically identical to
uncompressed files.
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CFF

Text file indicating the settings for current reconstruction.
Can be saved (Save settings as...) and re-applied to specimen at a later date.

7.4

Ba

e
Move wp

Batch Manager

Status Erree

Batch manager: ksting batch jobs and the datals

Desoription Vahoe A
Outpet formast  8-bit 8P
Dynamic range  -0.041 -~ 1557
HU scale Not calbrated
Oraw scales CFF
Cokr scale Grey
Recon sacion | -— 493
Recon step 1
Regionof n... Pl rOY
? | Undersample COFF N

Batch Manager opens when you ‘Add to Batch.” Alternatively

View > Show/Hide Batch Manager to toggle on/off.

Start Batch — Start current batch list. Only jobs with status as pending will be submitted.

Submit Again — Will start any failed jobs from the previously submitted list, or highlight a single job
to run again, and then click Submit Again.

Move Up — Moves a job up the priority list.

Remove — Removes the selected job from the list.

Remove all - Removes all the jobs from the list.

Jobs are shown on the left hand side and information about the highlighted job on the right hand

side.
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7.5 NRecon Menus

7.5a Actions
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Open Dataset
Opens dataset for reconstruction.
Navigate to required files and select one from the list. Usually .tif files.
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Or use
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Save As...
Save as current image as a BMP file

Or use H

Print
Prints the current image on display

Check dataset consistency
Used for troubleshooting purposes

Start Tview
This option is unavailable for OPT

Start DataViewer

Starts the external programme DataViewer. See Chapter 9.
Not available until at least one test section has been reconstructed.

Or use Jﬁ

Start CTAn
Starts external programme CT-Analyser, for 2D and 3D analysis (opens minimised programme).

Or use E (opens programme in window).

View/Edit a reconstruction protocol (*.rcp)
Enable to edit/view the reconstruction parameters for a protocol file (*.rcp)

Load from a protocol file (*.rcp)
Load reconstruction parameters from a protocol file

Load from a log file (*.log)
Load reconstruction parameters from a log file

Load from an ini file (*.rcp)
Load reconstruction parameters from an ini file

Load previous recon. Settings
Load previously used reconstruction parameters

Exit
Exits the programme
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Show/hide reconstruction window
Shows/hides the reconstruction window.

Show/hide connection window
Shows/hides connection window
NRecon can only operate with an open connection to NRecon Server.

T — ' x
Locat: ane and ardy oow perver on kool PC

R A N - A —

L
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Show/hide batch manager
Shows/hides the batch manager.
Shown at the bottom of the window.

Batch manager: Isting batch jobs and the detads

B b, reare B1

Used when reconstructing multiple specimens.

Show/hide colour window
Shows/hides colour window.

Showt/hide profile window
Shows/hides the profile window.

I

Profile

e

(0,99)=>{511,99): Si1 pixels, 11.466

;
|

P

aiiiiil

=

Zoom in
Zoom in on specimen.

D

Oruse “—

Or use
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Zoom out
Zoom out from specimen.

2

Fit on Screen
Fit specimen to screen

Or use

P
Oruse &=

Actual Pixels
Show specimen actual pixel size.

S

Show next image
Show next image.

Or use

Only available for shadow images, cross section images and after a “fine tuning” session.

Or use

Show previous image
Show previous image

Only available for shadow images, cross section images and after a “fine tuning” session.

Or use

Status bar
Shows Status bar when checked.
See Fig. 7b

Tool bar
Shows toolbar when checked

7.5¢  Options
Help

MNetwork configuration
Preferences

Network Configuration
Local version:
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In this version there is one and only one server: the connection is “built-in” and cannot be altered.
The only thing you might need to change is the port number (it is default to 1): click on button
modify to do this. After modifying the port number, NreconServer will be instructed to exit and will

be started automatically before a reconstruction is to be performed.
This is the same information as displayed in the connection manager window.

For Distributed Version please see software help file for more information.
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Only options that you may want to change are described here. For other options and further
information please see the software help files.
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System Directory
The default directory for Nrecon. This can be changed by clicking Browse...

Def. data drive
Default drive for data files. This can be changed by clicking Browse...

Default dynamic range: positive values only
Lower range, left hand bar in histogram or lower number is set to 0 at first preview or when auto
button is used.

Reconstruction Mode

Standard: should be selected for OPT data.

Accurate: is a non-standard reconstruction mode, bi-linear interpolation and larger convolution
kernel will be used. They will slow down the reconstruction and may or may not improve
reconstructed data.

i }h Sets the path to DataViewer programme.

“== Sets the path to CTAn programme.

7.5d Help

Help Topics

About NRecon...

Help Topics
Displays software help files.

About NRecon
Displays information about the software.
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7.6 NReconServer

NreconServer.exe must be running in order to use Nrecon. Once running, minimise the
programme and leave it running in the background.

NReconServer is part of the SkyScan cluster reconstruction programme NRecon/NReconServer.

NReconServer functions as a server in a client-server model: it listens at a certain port. Multiple
connections with clients (NRecon) can be established, but only one connection is effectively
active and all others are kept in a waiting list. As soon as the active client quits, the first client on
the waiting list is promoted to be the active client.

NReconServer is also the reconstruction engine. The active client (NRecon) can send request for
reconstruction. For more details, please refer to help files.

When idle, NReconServer consumes very little memory space and CPU cycles and therefore can
be left on as long as the PC is on. But during reconstruction, depending on the dataset, it makes
maximum use of the computer power (memory, CPU, disk access, temporary disk space, network
capacity). On a PC with multi-user configuration, only one NReconServer can be started. To
avoid problems, it is recommended to have one common account which runs NReconServer.

NReconServer and NRecon have to have the same version number to function properly.
The only action available in NReconServer is to change the port number: after changing, you will

be requested to re-start NReconServer. See more about port number in the installation guide of
NRecon in the NRecon Help Files.
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8 Reconstructing Scan Data

This chapter describes how to reconstruct data scanned with Bioptonics 3001.
See Chapter 7 for information on how to use NRecon.

In order to run NRecon you must first start NReconServer.exe. See 7.6

8.1 Starting NRecon:

MNRecon.exe

Double click
NRecon will check to establish a connection to NReconServer.

If NRecon and NReconServer are in the same folder, NRecon will start NReconServer
automatically. However it is advisable to start NReconServer first. Minimise
NReconServer, but leave it running.

On opening NRecon starts with the Open Dataset dialogue. See 7.2
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Navigate to the required dataset and open any tiff file from the scan. This loads the selected
dataset.
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8.2 Processing Specimens:

Select Misalignment.compensation
Once the dataset has loaded it shows the Misalignment view in the Settings tab.

LocH o anS Wty e v on kool

e E - Papees
[0 S

This shows two artificially coloured “shadow” images of the specimen. The programme selects
the value it thinks will produce the best misalignment compensation. It is best to test this value.
Using the arrows you can set different post-alignment values. To set the misalignment
compensation use the arrow keys to move the “shadow” images so they overlap as closely as
possible.

Fig. 8a shows specimen when out of alignment, compared with Fig. 8b, which is aligned.
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This provides a course alignment. When happy with the course alignment continue with Fine

Tuning.

Fine Tuning is required for accurate reconstructions. This is done in the Start tab.

Fine Tuning Misalignment compensation

Go to the Start tab
Select Fine Tuning

Select Post Alignment in Parameter fine-tuning window.
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Select the number of trials you want to perform, 5 is a good starting point. You may wish to do
more with a lower parameter step.

Select the parameter step, i.e. the amount each value will change by. Click Start.

Confirm fine tuning selections:

Attention!

5 trials will be performed on alignment values starting from 1.0 with increment 0.5, Continue?

[ OK ][ Cancel ]

Dialogue window shows the progress:

Fine-tuning/preview on alignment(1 of 5): at 256

0% done. OHOM3S passed.

( )

The reconstructed sections will open in the Output Option tab.
It is advisable to check multiple sections through the specimen to ensure the selected post
alignment value is accurate for the whole specimen.
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Reconstruct Test Section at Different Positions

Reconstruct test sections at the selected “Post Alignment” value.

In order to speed up reconstruction of test sections the Ring Artefact Reduction setting can be
turned off in the Settings tab.

Go to the StartTab

Select section through the specimen to reconstruct, indicated by the green line, see Fig.8c, over
the specimen, either by setting “position” value or left click and drag the green line over the
specimen to desired location.
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Fig. 8c Preview Section

Then click Preview.

This reconstructs one section with the selected Post alignment value at the selected section
location. It is advisable to reconstruct sections at more that one location through the specimen in
order to ensure the best Post Alignment value possible.

Results are viewed in the Output Option Tab, which will automatically open when there is output
to display.

The Dynamic Range may have to be adjusted to produce the best image, see 7.3d Histogram.
Fine Tuning is the best method for selecting accurate post alignment values.
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Reviewing Test Sections with Output Option tab
Test sections, or fine tuning output can be viewed in the Output Option tab.

L L T )

Fig. 8d Navigation and post alignment

A single section is viewed on the screen.
You can scroll through multiple sections i.e. fine tuning output using arrows in the toolbar.

W | Pq0000 |-

Previous ? Next
Image
name
Each section is identified with its Post Alignment value. See Fig. 8d
The section is aligned correctly when the section looks as sharp as possible, with no “double

images.” Select the section with the best Post Alignment value See Figs. 8e — 8g.
Fine Tuning is the best method for selecting accurate post alignment values.
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Fine tune(postalignment): 1.5 [0.0-3.5,40.5)

Fig. 8e Section Out of Alignment

linctuncipost-aligameng: 3.0 (1.0-30.+0.9)

Fig. 8f Section Slightly Out of Alignment

66 version 1.10.7 10/11/08



Fine-tune[postalignment]: 2.5 [1.0-3.0,+0.%)

Fig. 8g Aligned Section
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The Dynamic Range (grey level) may have to be adjusted to produce the best image, see 7.3d
Histogram.

Adjust the grey level to optimise the signal to background ratio. Make the signal as bright as
possible without saturating the image, see Fig.8h.

Finctuncipast sligament: 2.0 (1.0-3.0,10.5)

Fig. 8h Adjusted Image for DataViewer

You can see that this section has less background and is cleaner than the previous image, and
the signal is brighter. These settings are suitable for analysis of signal in DataViewer. Making
background visible allows orientation of signal. If this data was loaded into Bioptonics Viewer the
background would make setting parameters in Transfer Function Editor (11.3) more difficult.
Therefore it is advisable to remove all of the background if data is to be loaded into Bioptonics
Viewer.
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Fine tuncfpostalignment): 2.0 [1.0-3.0,+0.5)

Fig. 8i Adjusted Image for Bioptonics Viewer

The background has been removed by adjusting the Dynamic Range, and only the signal
remains: this is the ideal dynamic range for ‘signal’ data to be loaded into Bioptonics Viewer.

Select scale bars and the region of interest if required. See 7.3d.
Select the Destination Folder and output file type. See 7.3d.

Once happy with these settings the specimen is almost ready to reconstruct.
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8.3 Reconstruction

Check that the Output Options have been selected as above.

Go to the Settings tab and double check that the correct Misalignment compensation is selected
(as chosen after fine tuning).

Set the Ring Artefact Reduction and Defect Pixel Masking as required. See 7.3b

Go to Start tab.

Select the top and bottom sections of the specimen to be reconstructed. See 7.3.

NB if reconstructed data is to be processed through CT-Analyser or Bioptonics Viewer
e the top and bottom sections or ROI if selected, must be the same for each channel.

NB if reconstructed data is to be processed through Bioptonics Viewer
e for a brightfield scan NRecon will invert the data set automatically to make it suitable for
Bioptonics Viewer i.e. white signal on black background.

If you wish to view previews as black signal on white background do this using the
inverse box in colour window (see page 50).
Ensure the inverse is unchecked prior to reconstruction

e fora fluorescent scan data will be displayed as white signal on black. If you invert in the
colour window ensure it is unchecked prior to reconstruction.

A summary of all the settings can be seen in the Overview tab.
If only reconstructing one specimen click Start.

3D data can then be reviewed/analysed in DataViewer (See Chapter 9).
If reconstructing multiple samples click Add to batch.

8.4 Batch Processing

Batch Processing allows you to run more than one reconstruction at a time.

To add a reconstruction to the Batch list, set the reconstruction values as required and instead of
Start click Add to Batch on the Reconstruction tab. This opens the Batch Manager — see 7.4 —
and adds the job to the queue. This can then be done for any number of samples.

Once you have all the reconstructions ready to process, click Start batch in the Batch Manager.
This starts the first job in the queue and processes each in turn.
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9 Viewing Data Using DataViewer
This chapter details how to view original scans and reconstructed virtual sections.

9.1 Open DataViewer

rm.
<2
2]

DataViewer....

Double click on desktop to open data viewing software.

DataViewer window will open

¢ Urttied - Dt ¥ vewer

Por et o # |
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9.2 Load Image/Dataset
Actions > Open
or

Navigate to selected dataset.

Load Iimage'dataset
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DataViewer can be used to view both the original projection images (also known as Shadow
images) and reconstructed data (See Chapter 7).

Original Projection Images (OPI) are .tif files and can only be viewed in 2D mode.
Reconstructed sections are normally .bmp files. However you can specify the output file type in
NRecon. See 7.5.

The output data from NRecon is a 3D object and can be viewed in 2D mode or 3D mode. In this
instance 3D mode means that more than one orientation can be viewed at a time. Object opens
in 2D mode by default, unless selected otherwise.

2D loading is quicker than 3D.

To load reconstructed data in 3D select 3D view from Open As drop down menu in Load
Image/Dataset.

Samples can also be resized at loading by checking Resize.

If Resize is selected the original size (1) and the new size (2) is shown.

(See Fig. 9a)

This is advised for large samples; especially those scanned at high resolution (see 5.7), and
speeds up loading time.

If resize is selected, the option to Average in 3D becomes available. This is slower than 2D
averaging, but results in better and more accurate image quality. See Help files for further
information.
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Fig 9a Resize Information

9.3 Load for 3D viewing

If loaded in 2D mode samples can be loaded for 3D viewing in two ways
Actions > Load for 3D Viewing

View Options
Animation

Open... Ctrl+0

Load for 3D viewing

Save ... »

Exit

o3l
Or_

Only valid 3D datasets will have the option to view Coronal (Frontal) and Sagittal sections.

The 3D navigation window may open automatically in 3D mode if selected in the Preferences at
Viewing. This option can be switched off.
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9.4 Navigating through specimen

The X, Y, Z sliders can be used to navigate through the sample corresponding to that plane.

x

Colorf Data range

I~ Inverse [Grey -
[~ Smooth
Position
Y Z
064 292 87
-
-
-
A

Drag the sliders and the sections will change corresponding to the section number.

X navigates through the sagittal sections (when 3D view is loaded).

Y navigates through the coronal sections (when 3D view is loaded).

Z navigates through the transverse sections (in 2D or 3D view).

The position within the sample is also indicated by the red, blue and green lines over each
orientation. Clicking and dragging on one orientation will change the section displayed on the
other two orientations.

To rotate transverse (Z) section view: Ctrl + left click and move mouse to rotate.
To return transverse section to original position: Ctrl double left click.

To constrain direction of movement in 3D Navigation window: Ctrl + right click and move mouse
to rotate.

Inverse reverses black for white pixels (for 0-255). See Help files for more information.
Smooth When checked the specimens are smoothed according to the parameters set in the
preferences (See help files for more information).

For most OPT specimens smoothing is detrimental to the image quality as selecting smoothing
can obliterate fine detail. It may be useful when scanning specimens with very little fine detail.
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Data Viewer Menus
Actions

vew Optons

}
Open Ci+0
Animation

Animates sample i.e. automatically scrolls through the sections. Continues to play until animate is
turned off: Actions > Animate.

Animate can also be turned on and off using > or keyboard shortcut SPACE

Animation reverse
Reverses animation direction. Keyboard shortcut TAB

Open
See 9.2 Load Dataset.

Load for 3D Viewing
See 9.3

Save...

Coronal Image as a Single Image

Saves the current coronal (frontal) image as a single frame. Image can be saved as .bmp or .jpg
Coronal Images as a Dataset

Saves all the coronal (frontal) images as a separate dataset. This can then be loaded into
DataViewer.

Sagittal Image as a Single Image

Saves the current sagittal image as a single frame. Image can be saved as .bmp or .jpg
Sagittal Images as a Dataset

Saves all the sagittal images as a separate dataset. This can then be loaded into DataViewer.

Transaxial Image as a Single Image

Saves the current transverse image as a single frame. Image can be saved as .bmp or .jpg
Transaxial Images as a Dataset

Saves all the sagittal images as a separate dataset. This can then be loaded into DataViewer.

VOI

Saves the volume of interest (VOI). This is only available in 3D mode, and only when the resize
option is selected when opening the dataset. See 9.2

This allows you to save a particular part of your sample (e.g. a specific tissue) as a 3D dataset.
Selecting a VOI also means you can eliminate any unnecessary (black) i.e. frames with no
information contained in them. This makes the resulting dataset smaller which is useful for further
processing in Bioptonics Viewer or CT-Analyser.

Exit
Exits program.
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Zoom In
Increases zoom

Alternatively or keyboard shortcut +

Zoom Out
Decreases zoom

=

Fit On Screen
Resizes image to fill the whole screen

(=

Alternatively or keyboard shortcut =

Alternatively or keyboard shortcut *

Actual Size
Sets zoom to 100%. Dataset opens at 100% by default.

Alternatively or keyboard shortcut =

Hand-mode scrolling
Toggles hand mode off and on. When in hand mode image can be scrolled using the hand
cursor, (left click mouse and drag)

™

Alternatively or keyboard shortcut Ctrl H
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Rotate to...
Select 0, 90,,180 or 270 deg to rotate view.

Other.... Will open Rotate in the image plane window. Enter the degrees of rotation required.
(Alternative: CtriHeft-mouse on the image)

Rotate to angle (n deg, CCW):

New value: | 45 000|

|

[

Alternatively Ctrl + left mouse and drag over bottom left image (XY)

Reset 3D Distance reference point

&

>
Measures the distance between two points in 3D using this icon. ®

Set the cross position at starting point/pixel, then click on the icon to record the current position
as the reference point, then set crosspoint at end point/pixel. The distance between start and end
point will be displayed on Status Bar.

View in 3D mode (244,300, 216)->(244,266,449): 2.032mm (244, 485, 416)=0 (0%) Zoom 100%
Distance
VOI Mode

Volume of Interest Mode.
VOI mode is only available if dataset has been resized when loading.
VOI mode allows loading/saving of specific volumes from the sample.

2D Mode
Toggles 2D mode off and on.

Show/Hide Coronal View
Shows/Hides Coronal (Frontal) section view when in 3D mode.

Show/Hide Sagittal View
Shows/Hides Sagittal section view when in 3D mode.
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Show/Hide Control Window
Shows/Hides Image Control window.

image contral x
Colorf Data range

9 ‘0
[T Inverse I?,rey -

[T smooth
Positon
X Y Z
264 292 87
A D

Show/Hide 3D Navigator Window

Shows/Hide 3D window.
Only appears when all 3 orientations viewed in 3D mode.

It can be configured to appear automatically in Preferences at Viewing.

Crertaton

Alternatively
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Show/Hide Profiling Window

Shows/Hides Profile window.

To obtain a profile right click and drag across the sample. The resulting profiling window shows a
histogram of grey values. The profile can also be saved using the Save button in the profiling
window.

Profile ®
¥ Gobel scale _jm
Profie rformation

About Dataset/Image

Shows information about the current dataset (or image).
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Status Bar
Toggles status bar off and on.
See Fig 9b

Tool Bar
Toggles tool bar off and on.
See Fig 9b

Ty
Fig 9b Tool and Status Bars
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Options
Options
Preferences at loading

Preferences at viewing
Change image unitto ... »

Help Topics

About DataViewer...

Preferences at Loading
Allows you to customise DataViewer behaviour at loading. Changes are only applied at next
loading.
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Folder for temporary files
Defines location of the file to store dataset during program operation. This file will be removed
after closing program. Use the Browse... button to specify a directory. Default is C:\tmp

Start Loading Automatically for a 3D Dataset
If checked automatically loads dataset as 3D by default. Loads in 2D if unchecked.

Start Animations When Opened in 2D Mode
Automatically starts animation in 2D mode when checked.

When Load a 3D Dataset
If checked, dataset will be resized if bigger than 512 million (mIn) voxels (default), or a size of

your choice.

Standard resolution dataset = 135 Min.voxels
High resolution dataset = 1080 Min.voxels
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Preferences at Viewing
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Position Marker
Changes appearance of the position marker.

Profile
When linear interpolation is not checked, nearest-neighbour interpolation applies. Averaging
2N+1 lines to create a profile.

Smoothing
Set smoothing parameter to be used when smoothing is selected in the main window. See help
files for further information.

Animation
Adjusts frame rate (frames per second) of animation.
Also allows you to pick the orientation animated in 3D mode.

Misc...

Allow Shadow Images in 3D Mode

When checked, 3D view will be enabled for shadow/projection dataset.

The reference shadow image is an original projection image and can be viewed in the control
window (see Fig. 9¢ & Show/Hide Control Window).

Show 3D Navigation Window Automatically

When checked, the 3D navigation window will be shown whenever it can be shown i.e. in 3D
mode when both coronal and sagittal views are selected.
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Show the Reference Shadow Image if Available
When checked the reference shadow image (original projection image from scan) will be shown if

found. Shown in control window (see Fig. 9c & Show/Hide Control Window).
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Fig. 9c Reference Shadow Image

Change Image Unit to...
For OPT this should always be set to Grey. Do not Change this setting.

Preferences at loading | i,;_; 1
Preferences at viewing . Qa ;Egl 11 b
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Help Topics ‘ et S
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About DataViewer... [

|
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Help Topics
Displays Help Files. Information about the program.

?

Alternatively

About Dataviewer
Information on Dataviewer.
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10 Quantitative Analysis Using CT-Analyser

CT-Analyser can perform quantitative analysis and segment OPT data. This section presents a
brief overview of its capabilities. More information can be found in:

Start Menu > Programs > Bioptonics 3001M > CTAn User Manual
Start Menu > Programs > Bioptonics 3001M > CTAn Guide to Structural Parameters

CTAn menu options are detailed at the end of this chapter.
First load the dataset:

CTAnN supports TIFF, JPEG and BMP file formats. The output of NRecon is BMP so this is the file
format which will be commonly used.

The CTANn window shows a list of section file names at the top of the screen, the image of the
current section on the left hand side of the screen and information and tools on the right hand
side of the screen.
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The first step is to select the region of interest or ROI. This step is performed by tracing around
the region of interest with the left mouse button. Other shape tools may be selected from the
Region of Interest menu. CTAnR is able to interpolate the region of interest you require between
sections where the region of interest has been specified. Trace around as many sections as
required to select the necessary region of interest. The sliders at the right hand side of the screen
allow the top and bottom sections of the region of interest to be selected. The blue squares on the
region of interest boundary are control points which may be dragged to edit the selected area.
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The following image shows that regions of interest have been specified on sections 186 and 192
and CTAn has interpolated regions of interest between them.

The next step is to define the thresholds which determine the areas of the dataset to be

quantitatively measured. On the following image, a minimum threshold of 64 and a maximum of
165 have been chosen.
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By clicking on the “Toggle halftone view” icon it may be easier to select the correct thresholds.
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The next stage is to click the Processed Images button. This screen displays quantitative
statistics of the shapes defined by the selected thresholds. By changing the “Palette” to Colour
and by clicking the button marked “Show absolute values in histogram” it is easier to interpret
these results.

The statistics calculated by this part of the program are extensively documented in the manual
entitled “CTAnN Guide to Structural Parameters” which can be found at:

Start Menu > Programs > Bioptonics 3001M > CTAn Guide to Structural Parameters

The statistics shown are for the current section. The current section may be changed by selecting
a different section in the section file name list.
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By clicking on the button marked “Individual 2D object analysis” the statistics for all of the objects
identified on the current section can be analysed. Clicking on a row in the table will highlight this
object on the section. These results may be saved to a text file and analysed using spreadsheet
software.

|

By right clicking on an object in the section view and selecting object analysis, the statistics for

the object can be displayed.
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Zoom In

Zoom Qut

Ackual Size

B Animation
™ Hand mode
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CTAn can calculate some 3D statistics by considering the set of statistics produced for each
section. Click on the “3D Analysis” button and choose the required options. For OPT the most
useful statistics will be “Tissue Volume”, “Bone Volume” (where bone means object selected by
the threshold), “Tissue Surface” and “Bone Surface”. These results may be saved to a text file
and analysed using spreadsheet software.
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The “Custom Processing” screen allows the user to perform the same analysis detailed in this
tutorial but in an automated fashion. This allows the user to perform the same analysis on several
specimens. Tasks can be selected and added to the Task List and parameters can be edited by
double clicking on the entries in the Task List.
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CTAn can display a profile bar displaying a line graph of brightness values along a line drawn by
the user. Select the “Raw Images” tab and click on the “Toggle profile bar” button. Draw the
profile line with the left mouse button on the section window. The profile is displayed on the
graph.

LES
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CTAnN can reslice the dataset along this profile bar by clicking on the “Reslice model” button. The
slice spacing and number of slices can be specified to make the resliced data more accurate.
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This resliced dataset can be saved to a new folder and further manipulated with CTAnN,

DataViewer or Bioptonics Viewer.
e
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Measuring Dataset Features

CTAn has a built in measurement tool which can be used to measure features in your dataset.
Activate this tool by clicking the icon on the main menu bar.
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Click Angle, Line or Path tab to choose the type of measurement. Draw on the image between
the features you want to measure. When happy with the measurement, click Add to record in the
list of measurements. If Autofill is clicked measurements are automatically added as they are
made. The list of measurements may be cleared by clicking Clear and recorded to a file by
clicking Save. Click Close when finished taking measurements.

Segmenting Datasets

A final very useful function of CTAn is to use it to segment datasets for loading into Bioptonics
Viewer. To do this, select the region you wish to segment as a region of interest in the Regions of
Interest tab. Click on the “Save ROI” button to save the description of this region of interest for
later use. In the same way previously saved regions of interest can be loaded using the “Load
ROI” button. The segmented area can be saved to a new dataset for loading into Bioptonics
Viewer by selecting “Save new dataset from ROI”. However, for Bioptonics Viewer to be able to
load the segmented area correctly, the user must ensure that the preferences option “Save
Images” on the “Region of Interest* tab is set to “Full area”. The following image shows how this
preference window should look:

S
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CTAnNn Menus

This section provides a brief key to the menu buttons in CTAn. More comprehensive information
can be found in the CTAn User Manual which can be found in:

Start Menu > Programs > Bioptonics 3001M > CTAn User Manual

Main window toolbar

= b

1 @EME BEaA0 W

From left to right:
Open Image or Dataset

Open a BMP, TIFF or JPEG dataset. BMP is the format produced by NRecon so will be

the most commonly used format
Toggle Animation

Toggles animation of the section view
Raw Images

Brings focus to the Raw Images tab.
Regions of Interest

Brings focus to the Regions of Interest tab
Binary Images

Brings focus to the Binary Images tab
Processed Images

Brings focus to the Processed Images tab
Custom Processing

Brings focus to the Custom Processing tab
Measure Tool

Opens the measure tool window
Hand Mode

Allows the user to pan the dataset with the mouse when zoomed in
Help

Activates contextual help

Region of interest toolbar
Fre & 4 O k- & =8 o

From left to right:

Load ROI
Load a description of a Region of Interest from disk

Save ROI
Save a description of a Region of Interest to disk. Always do this before saving a new
dataset from the region of interest

Save new dataset from ROI
Saves a new dataset from the defined region of interest. Use this to save a segmented
dataset which can be loaded into Bioptonics Viewer

Cut ROI
Cut this section’s region of interest description to the clipboard. Sets the region of interest
to Interpolated ROI

Copy ROI
Copy this section’s region of interest description to the clipboard

Paste ROI
Paste the region of interest previously cut or copied to the clipboard to the current
section.

Select ROI Shape drop down menu
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Select the ROI shape drawn using the mouse. Normally this should be Polygonal. The
options are: Rectangle, Square, Elliptic, Round, Polygonal, Empty and Interpolated
Expand ROI
Expands the bounding rectangle of the default region of interest to size of the image.
Copy ROl to all images
Copies the currently defined region of interest to all sections
Reset all ROI
Resets the region of interest to the default on all sections
Subtractive ROI
Gives the inverse of the selected region i.e. what was inside the bounds of the ROI will
now be outside and what was outside the bounds of the ROI will now be inside.

Reslice Toolbar

=R

From left to right:
Save Image
Saves a single section of the resliced dataset
Save Resliced Images
Saves all the resliced images to a new dataset which can be reloaded into CTAn or
Bioptonics Viewer
Close Window
Close the Reslice window.

Binary Images Toolbar

N E G e | B

From left to right:
Auto threshold
Sets an automatic threshold
Save histogram
Saves the histogram data to a text file
Save binary selection
Saves the binary selection as a new dataset which can be reloaded into CTAn or
Bioptonics Viewer
Create 3D model
Create a 3D isosurface which can be used with CTVol. This model is not usable by
Bioptonics Viewer
Logarithm scale
View the histogram with a logarithmic rather than linear scale
Density range calibration
Used for calibrating X-Ray images. Not of use for OPT images
Toggle halftone view
Toggles halftone view which is useful for seeing the coverage of a selected threshold
level
Toggle ROI view
Toggles whether only thresholded objects inside the Region of Interest are shown
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Processed Images Toolbar
@ 5 dg Sim vis

From left to right:
Individual 2D object analysis
Opens 2D object analysis window
3D analysis
Opens 3D analysis window
Save 2D analysis results
Saves 2D analysis results from all sections to a text file
Save histogram of distribution
Saves histogram to text file
Area histogram
Shows histogram of objects by area rather than number
Show absolute values in histogram
Shows the number of items in each histogram bin
User defined histogram intervals
Allows the user to define their own histogram bins.

Profile Toolbar
¥ 7 | g

From left to right:
Cut Model

Cuts model along specified profile
Reslice Model

Opens the Reslice Model window
Maximal Intensity Projection

Creates a Maximum Intensity Projection view using the specified profile

Apply ROI

Clips the raw image view to the region of interest specified in the Regions of Interest tab.
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1 Bioptonics Viewer
Bioptonics Viewer is a revolutionary visualisation tool for the display of multi-channel volume

datasets. The programme supports clipping the dataset with multiple planes to reveal internal
structure, and the creation of isosurfaces.

111 Getting Started

Double click the icon on the desktop or in the quick launch menu to open Bioptonics Viewer

AN
a A

Bioptonics
Viewer

When first started, Bioptonics Viewer presents the user with the following screen:
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Bioptonics Viewer can visualise volumetric datasets in a number of formats: WLZ volumes, RAW
volumes and stacks of PNG and Bitmap (BMP) files. In normal use Bioptonics Viewer will be used
to visualise the output of NRecon or CT-Analyser (CTAn). NRecon and CTAn produce stacks of
BMP files.
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11.2 Open Dataset

Select File > Open > BMP/PNG Slice(s)

File

4
lﬁ‘m WLZ Yolume Chri+w
& save ¥ RaAW Volume Ctrl+R
& Export > BMP/PNG Slice(s) Ctrl+S

Exit Q|

Navigate to the folder containing the dataset and click on one of the image files. All the files in the
dataset will be opened automatically by Bioptonics Viewer.

NB- ensure that brightfield scan data has been reconstructed with a black background and white
signal. Bioptonics Viewer requires datasets to be white on black. See 8.3

A dataset can be loaded into a single colour channel (R for Red, G for Green or B for Blue) or
loaded into all channels (RGBA) with the following menu.

3:,':7&_;;,,,‘:,4 ver vl 60 ' 4‘a
Rees | A s | s |

When opening multiple channel data, if you require a red channel it must be loaded first. Blue
and green channels can be loaded in any order. If a red channel is loaded after a green channel
or blue channel is loaded, the green and blue channels will be cleared.

If the dataset is loaded into all channels (RGBA) it will appear in greyscale. If, for example, the
dataset is loaded into the Red channel, other datasets may be loaded into the Blue and Green
Channels and displayed simultaneously. In this way multiple channel datasets may be displayed.

I Please Wait @

Loading PNG/BMP Yolume...

pnopuonopnon 7%

Cancel |

Once the dataset is loaded it can be manipulated with the mouse.

e Leftclick and drag to rotate the dataset

¢ Right click and drag to zoom in and out

e Middle click (usually by pressing down on the mouse wheel) and drag to translate the
dataset (move left, right, up and down).

On the right hand side of the screen are images showing X, Y and Z sections. The section shown
can be changed by dragging the slider next to the image.
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11.3  Transfer Function Editor

r
Click on the icon . to open the Transfer Function Editor. This tool allows the user to
change the colour and opacity of the dataset.

AN

If at this point background levels are too high, it may be necessary to repeat
reconstruction to produce the highest quality images for Bioptonics Viewer.
Refer to page 65 for suitable settings.

The 3D rendering window will update in real time as the transfer functions are changed. However,
if your dataset is very large, it may only update once per second or even less frequently.

If the rendering speed is not fast enough it may be altered using the settings editor window. See
11.7i.

08080

-~
™3
A |
-4
-
-
~3
®.3
»

FDNEEEEREORNDEEES

The Transfer Function Editor can affect two components of the image, the luminance and the
opacity. The luminance is essentially the colour information of the rendering. Higher luminance
values appear as brighter colours. The opacity sets how much a specific voxel contributes to the
final image. Higher opacity values make the dataset appear more solid, lower opacity values
make the dataset appear more transparent.

The luminance and opacity properties of each channel are set independently and can be set for
each channel individually (Red, Green or Blue) or for all channels at once (Intensity). This means
there are 6 factors which can be adjusted: Luminance for each of the Red, Green and Blue
channels and Opacity for each of the Red, Green and Blue channels.

101 version 1.10.7 10/11/08



There are three ways to affect each of these factors:
e Adjusting the minimum and maximum thresholds
e Adjusting the brightness and contrast.
e Adjusting the graph

Adjusting Opacity

For best results first adjust the minimum threshold on the opacity channel for each of the
channels. It is best to adjust each channel independently by using the left hand side toolbar
controls to select which colour channels are displayed (See 11.7c). Any voxels with values below
the minimum threshold or above the maximum threshold will be made invisible and will not be
displayed. It is not common to have to adjust the maximum threshold. These settings are useful
for removing noise (background) from the dataset. The sliders can be moved more precisely by
clicking on their current position and then moving the mouse wheel. The minimum and maximum
threshold values are displayed as vertical lines on the graph.

For anatomy channels the optimum value will be fairly low, perhaps around 10 - 40, although this
is totally dependent on the dataset and the parameters chosen in NRecon. For Signal channels,
the required minimum threshold may be much higher, say 70 to 100. Again, this value is totally
dependent on the dataset and parameters chosen in NRecon. If the values chosen do not allow
sufficient dynamic range to produce a pleasing image, perform the reconstruction again in
NRecon and choose different output parameters. The reason for this is that NRecon performs its
reconstruction in 16bits (giving 65536 possible brightness values) and Bioptonics Viewer
performs its processing in 8bits (giving 256 possible brightness values). The reconstruction
parameters must be chosen so that the 8bit range used by Bioptonics Viewer maximises the
dynamic range of the dataset.

Once the minimum threshold has been set, the next stage is to adjust the brightness and contrast
controls on the opacity channel if necessary. Generally these controls are only altered if the user
wants to make the dataset more transparent or opaque than it currently is. To make the dataset
much more opaque it is best to decrease the contrast value and then decrease the brightness
value. Some experimentation will be required to produce the desired effect. The sliders may be
changed more precisely by clicking on the slider and moving the mouse wheel.

Finally the most precise control is achieved by changing the graph. The graph in the centre of the
window shows the input values on the horizontal axis, which are the original values in the dataset.
The output values are shown on the vertical axis and are the values which will be displayed in the
rendered image. By tracing a line from a given input value on the horizontal axis to the curve and
then over to the vertical axis, the output value can be found. A straight diagonal line increasing at
forty-five degrees from left to right will leave the dataset unchanged i.e. the input and output
values will be the same. The curve control points are displayed as yellow squares. Left click and
drag the curve control points to change the relationship between the input and output values.
Right click on the graph to add additional curve control points.
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Image shows the conversion of input value (192) to the output value (192) displayed in the
rendered image.

In this example the image would remain unchanged. A curved graph would result in a different
output value for the same input value.

In opacity mode, the graph can be used to change the relationship between areas of different
brightness in the image. It may be used to make darker areas more transparent while making
lighter areas more opaque for example. Adjust the graph to suit the visual effect required. Some
experimentation may be required to produce the best effect.

Adjusting Luminance

By changing the channel mode to luminance, the same controls can be used to affect the
luminance properties of each channel. The luminance properties should only be changed once
the user is happy with the opacity of the image, as changing the opacity changes the user’s
perception of the luminance properties of the image.

Generally this means that the user will only adjust either the brightness or contrast to make either
the whole channel brighter or darker, or the user will adjust the graph to change the relative
colours of the channel. For example the user may wish to make the lighter areas of the image
lighter in colour while keeping the darker areas the same colour. The user would accomplish this
by increasing the right hand side of the luminance graph while keeping the left hand side
unchanged.
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Image adjustment step by step
The Anatomy dataset has been loaded into the blue channel and the Signal dataset has been

loaded into the green channel.

Blue (Anatomy) channel with background noise before minimum threshold on opacity channel
set:
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Blue channel with background noise removed. Minimum threshold on opacity channel set to 14:
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Brightness and Contrast reduced on opacity channel to make this channel translucent:
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Green (Signal) channel with background noise before minimum threshold on opacity channel set:
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Green channel with background noise removed. Minimum threshold on opacity channel set to 70:
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Combine green and blue channels:
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Final image with green channel luminance adjusted using the graph. The areas of the green
channel with high intensity have been made brighter while the areas with low intensity have been
made darker:

107 version 1.10.7 10/11/08




11.4  Clipping Editor

Bioptonics Viewer can clip loaded datasets to reveal internal structure by setting one or more
cutting planes.

Open the Clipping Editor by clicking the icon .

m Clippang Editor E @
Ogewrg
Fhe Crarce
= Doer [P Goner B W Sufece
L N -
tora Qg P 1
Feset Crert Cuttrg Plare 2
Foce X Gtrg Mare )
Sew M | Cung Plare 4
Cutirg Pare &
»' ) Pare b
Ocon

Select which channels (Red, Green and Blue) you wish the cutting plane to apply to and whether
the cutting plane should apply to the isosurface (see 11.5)

Select a cutting plane
The cutting plane will be shown on the 3D rendering window in yellow.

GNEREEEEEDENEES
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The cutting plane may be moved into or away from the dataset with the right mouse button and
may be tilted with the left mouse button. All six cutting planes may be set by the user if
necessary.

Drag with the right mouse button to move the cutting plane into your dataset to reveal its internal
structure.

If the cutting plane “disappears” it could be that the clipping plane has been dragged away from
the image. To relocate the clipping plane change the zoom or press Reset Current to reset its
position to the default.
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11.5 Making an Isosurface

Using the Isosurface Editor an isosurface can be created. An isosurface is a surface linking points
of constant value.

Open the Isosurface Editor by clicking the icon .

lsoSutace

fie Crarcec
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@ see |
Actorn

New |

Duwe |

Select the channels (Red, Green or Blue) from which the isosurface will be constructed.
Click New. The following window will appear:

I Iso-Surface Properties E|

Noerre:

P

Isofrface Qualty: 300%

IsoSurface Value: 0

SO N TR R

Colour:

Isosurface Quality affects how long it takes to calculate the isosurface, how closely the
isosurface follows the shape of the volume it encloses and the complexity of the isosurface
shape. When trying to determine the best isosurface value the user should create isosurfaces on
low quality say 20-50%. Once the best isosurface value has been found the user may increase
the isosurface quality.

Isosurface Value uses the “marching cubes” algorithm so voxels at this value or above are
included in the isosurface.
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Give the isosurface a unique name, select a low quality (higher quality isosurfaces will take longer
to create) and enter the value to be used to construct the isosurface. This value may be found by
placing the cursor on an area (right click in the virtual sections to show a cross at the point of
interest) which you would like to be the edge of the isosurface and using the info display toggle
(see 11.7¢) to find the pixel value at that point. It may take some adjustment of this value in order
to get a good isosurface.

Change the isosurface colour to a contrasting colour which will be easily visible against both the
other colours in the dataset and the background. Once a good isosurface value has been found,
remake the isosurface with a high isosurface quality setting.

Details for each isosurface can be changed by double clicking on the isosurface name and
displaying the “Isosurface Properties” window.

11.6  Exporting Images and Movie Frames

Bioptonics Viewer can save single rendered frames and animations.

M Bioptonics Viewer v1.60

Fie

@ Open ’ W
@
H BMP Movie Frames  Alt+M

Exit  Cur+Q Render [mage Alt4+P

Select File > Export > BMP Movie Frames. Select the folder to which the animation will be
saved. The following window will appear listing a series of movies which Bioptonics Viewer is
capable of creating. Choose one and the frames for this movie will be saved to the specified
folder.

Select File > Export > Render Image. Select the filename to which the image will be saved. The
current 3D rendering window view will be rendered as a single image and saved to the filename.

M BioptonicsYiewer v1.60 §|E

00" Asas
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¥ Clp « X Clp

Y Sections + X Sections + Z Sechons

The following animations can be made:

e 360° spin around Y axis
720° spin around Y axis
360° spin around Y axis followed by 360° spin around X axis
360° spin diagonally around YX axis
Y-Clip + X-Clip. Clips dataset in Y dimension then in X dimension
Y sections followed by X sections followed by Z sections

The animation is saved as a series of BMP images. Third party software is then required to make
the movie, e.g. Quicktime Pro.
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11.7  Bioptonics Viewer Menus
11.7a Main Window:

088 a Toolbar

INEEEEEE DD REDES

Rendering Window

BIOFTOMNKCS.

The 3D Rendering Window shows the volume and surface rendered image.
Virtual sections are shown as reference images on right hand side. Slider bars allow the user to
scroll through the section images for each orientation.

11.7b Top Tool Bar

Settings Editor:

Opens dialogue box to change image quality settings.
See 11.7i

. Isosurface Editor:

Opens dialogue box to edit the 3D volume and make an isosurface.
See 11.5
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. Clipping Editor:

Opens dialogue to change clipping planes i.e. the ability to “cut into” the 3D volume.
See 11.4

Transfer Function Editor:

Opens Transfer Function Editor which allows settings for the 3D volume e.g. colour,
opacity etc. to be manipulated.
See 11.3

P
. Lighting Editor:

Opens dialogue box to change lighting settings.
See 11.7h
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11.7c Side Tool Bar

m Intensity/RGB Channel Toggle

Toggles the display of all three colour channels

E Red Channel Toggle

Toggles the display of the red channel

D Green Channel Toggle

Toggles the display of the green channel

@ Blue Channel Toggle

Toggles the display of the blue channel

i
Maximum Intensity Projection Toggle

Toggles whether the rendering is performed using Maximum Intensity Projection or using
Ray Casting. Ray Casting is the default viewing mode as it gives more depth information
to the viewer.

The following two images show the same specimen rendered using maximum intensity
projection and using ray casting. In the maximum intensity projection image, the intensity
of each pixel in the image is determined by the highest intensity of any voxel intersected
by the ray projected from the pixel through the dataset. In the ray cast image, the
intensity of each pixel is calculated by adding up the contribution of each voxel
intersected by the ray projected from the pixel through the dataset.

Maximum Intensity Projection image:
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Ray Cast image:
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E Viewing Direction Options

Selecting one of these options changes the 3D rendering window view to the specified
direction. Front, Back, Left, Right, Top or Bottom may be selected.

E Slice View Options

115

Slices Mode: Off

E Front

Back.
E Left
Right
ks Top
Bokkom
Al

Virtual section positions are not shown on the 3D rendering window:

- R
Wireframe

Solid Textures

Alpha Masked Textures

IE8A ..
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Slices Mode: Wireframe
Virtual section positions are shown as coloured lines on the 3D rendering window. This is
the default:
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Slices Mode: Solid Textures
Virtual sections are shown in the 3D rendering window on black rectangles:

FEERNEEEE N DENDES
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Slices Mode: Alpha Masked Textures
Virtual sections are shown in the 3D rendering window on black rectangles whose edges
are clipped:
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Te
Background Colour Options
Opens dialogue box to change the background colour in the 3D rendering window.
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Bounding Box Toggle
Shows Bounding box in 3D rendering window when checked.
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Light Display Toggle
Displays the position and orientation of the light source in the rendering window
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E Axis Toggle
Displays the 3D axis (XYZ) in the rendering window
[~

S0080
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g Cursor Toggle

Displays the 3D cursor position in the rendering window. This corresponds to the cursor
position indicated by the small yellow cross in the section views.

—(192,82,138)

Surfaces Display Toggle

Toggles whether isosurfaces generated using the isosurface editor are displayed in the
rendering window

-
Frames Per Second Display Toggle

Toggles whether the rendering speed in frames per second is displayed in the rendering
window
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Info Display Toggle
Displays the information window. The following information is shown:

Dataset path

Dataset type

Resolution of rendering
Position of the cursor
Colour at cursor position

B BioptoatcsViewer vi 60
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11.7d File Menu

121

Open

Save
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Ext  CtrQ l
e

WLZ Volume
Opens WLZ volume dataset.

RAW Volume
Opens RAW volume dataset.

BMP/PNG Slice(s)
Opens a stack of PNG or BMP images.
NRecon and CTAnR output a stack of BMP images.

MR Bioptonics Viewer v1.60

File
9“- I~
E RAW Volume Ak+R
B export Y BMPIPNG Slice(s) AR+S
Ext  Ci4Q |
=
RAW Volume

Saves clipped dataset as a RAW volume.

BMP/PNG Slice(s)
Saves clipped dataset as BMP or PNG slices depending on the file extension

chosen.
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Export

I Bioptonics Viewer v1.60

Fie
@ Open
N / -
H Save - \
g BMP Movie Frames Alt+M
Exit  Cul+Q Render [mage Alt+p

BMP Movie Frames:
Creates an animation of the current dataset and saves to a series of frames in
BMP format. See 11.6.

Render image:
Saves a single image of the rendering window with the current settings. See 11.6.

Exit
Exit Bioptonics Viewer.

11.7e Isosurface Editor

W ho-Surface Editor

lSutsce |

Table
Lists previously created isosurfaces. Double click on an entry to edit the parameters
using the Isosurface Properties window and the isosurface will be recreated.

Open
Opens a previously saved isosurface description in OBJ format.
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Save
Saves an isosurface to an OBJ file which may be loaded into other programs or reloaded
into Bioptonics Viewer.

New
Creates a new isosurface. Opens the Isosurface Properties window. See below.

Delete
Deletes the selected isosurface.

Red
Selects whether the isosurface should be created from the Red channel.

Green
Selects whether the isosurface should be created from the Green channel.

Blue
Selects whether the isosurface should be created from the Blue channel.

Close
Closes this window.
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Isosurface Properties
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Name
Sets the name for this isosurface.

Isosurface Quality
Sets the quality of the created isosurface.

Isosurface Value

Sets the isosurface value used to create the isosurface. See 11.5.

Colour
Sets the colour with which the isosurface will be shaded.

OK
Creates the isosurface with the above parameters.

CANCEL
Closes the window without creating an isosurface.
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11.7f
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Clipping Editor
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Open
Opens a previously saved clipping configuration in SLC format.

Save
Saves the current clipping configuration to SLC format.

Reset Current
Resets the position of the currently selected cutting plane.

Reset All
Resets the position of all cutting planes.

Show All
Shows the position of all cutting planes.

Red
Selects whether the current cutting plane applies to the Red channel.

Green
Selects whether the current cutting plane applies to the Green channel.

Blue
Selects whether the current cutting plane applies to the Blue channel.

Isosurface
Selects whether the current cutting plane applies to the isosurface.

Clipping Planes
The list of clipping planes. Select one to change its position. See 11.4.

Close
Closes this window.
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11.7g Transfer Function Editor
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Graph
Displays graphically the current transfer function. See 11.3.

Open
Opens a previously saved set of transfer function configurations in TFN format.

Save
Saves the current transfer function configurations in TFN format.

Intensity
Sets the current transfer function to all three colour channels Red, Green and Blue.

Red
Sets the current transfer function to the Red channel.

Green
Sets the current transfer function to the Green channel.

Blue
Sets the current transfer function to the Blue channel.

Luminance
Sets the transfer function to affect the dataset’s luminosity.

Opacity
Sets the transfer function to affect the dataset’s opacity.

Reset Current
Resets the current transfer function. This is not an “undo”.
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Reset All
Resets all transfer functions.

Invert
Inverts the dataset e.g. values which were 255 in the dataset will now be 0.

Brightness
Adjusts the brightness of the whole dataset. Adjusting this may be easier than setting a
transfer function.

Contrast
Adjusts the contrast of the whole dataset. Adjusting this may be easier than setting a
transfer function.

Min Threshold
Sets the minimum threshold. Voxels with values below this value will not be displayed. To
adjust the threshold precisely click on the slider and then move the mouse wheel.

Max Threshold
Sets the maximum threshold. Voxels with values above this value will not be displayed.
To adjust the threshold precisely click on the slider and then move the mouse wheel.

Close
Closes this window.
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11.7h Lighting Editor
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Open
Unused in Bioptonics Viewer 1.6.1

Save
Unused in Bioptonics Viewer 1.6.1

Shader Programs

The program selected here determines how the image is lit and hence the look of the
dataset. The programs are named for the algorithms used to compute reflections and
lighting in the image. Change the program to suit the aesthetic preference. The programs
may use the following colours for different effects. The default program is “Multi

Channel NOLIGHT”

Ambient Colour
Sets the colour of ambient or background light in the image.

Diffuse Colour
Sets the colour of diffuse reflections in the image

Specular Colour
Sets the colour of specular reflections in the image

Light Position
Determines the position of light sources used for lighting the dataset. The light position
can be shown in the rendering window with the Light Display Toggle

Altitude
Sets the vertical component of the light sources position. Default is 180 degrees.

Azimuth
Sets the horizontal component of the light sources position. Default is 180 degrees.
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Settings Editor (Viewing Preferences)
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Open
Unused in Bioptonics Viewer 1.61

Save
Unused in Bioptonics Viewer 1.61

Max Texture Size

Determines the dimensions of the 3D texture used to display the dataset. The dataset will
be automatically resized to fit. For example, if 256 is selected a texture of size
256x256x256 voxels will be used. The default value is 384, which means the dataset will
be displayed at 384x384x384 voxels. This provides a good trade off between image
quality (a higher number produces higher quality images) and speed (a higher number
means more data to process and so slower operation). Users with more powerful
graphics cards can select 512 to render at 512x512x512 voxels or 1024 to render at
1024x1024x1024 voxels. Selecting texture sizes which are larger than the graphics card
can cope with may cause Bioptonics Viewer to crash.

Render Quality

This setting determines the quality of the images produced by the program. In normal use
this is set to 5 for a good trade off between speed and image quality. Image quality is
improved by setting this to a higher number and users with more powerful graphics cards
should set this as high as possible. Reducing this number will decrease the time taken for
images to render.

Render Quality (On Move)

This value determines the rendering quality when the user is moving the dataset
onscreen with the mouse. Setting this value lower results in the screen updating more
quickly but with lower quality. Setting this value higher results in the screen updating
more slowly but with higher quality. The default is ON with the value set to 5. Turning this
option OFF results in the program rendering at the quality setting chosen in the Render
Quality field at all times.
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Post Process

When this option is turned on the program performs image processing to further visually
improve each rendered image. The default is ON with the value set to 100. Increasing
this number produces a more pronounced effect.

130 version 1.10.7 10/11/08



This page has been left blank intentionally.

131 version 1.10.7 10/11/08



12 Using CTAn and Bioptonics Viewer Together

This chapter describes how CTAn and Bioptonics Viewer may be used together to produce
rendered images composed of volume rendered channels and isosurfaces produced from a
segmented area.

The specimen used in this example is an E12.5 mouse embryo scanned on GFP1 for
autofluorescence and Cy3 for PECAM signal. The heart area will be segmented out from the
GFP1 channel and saved to a new dataset using CTAnN. Prior to starting this process the GFP1
channel was examined in DataViewer and it was determined that the heart tissue was present on
the transverse sections 264 to 320.

The first step is to load the GFP1 dataset into CTAn and begin the segmentation process. A
section in the middle of the range was chosen (304) and the heart tissue drawn around freehand
in the “Regions of Interest” tab. From here move up and down the range until the regions of
interest adequately cover all of the heart tissue.
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CTAnN interpolates the region of interest on sections between where the user has specified a
region of interest. In areas where the shape of the tissue changes more dramatically it is
necessary to use more specified regions of interest. In areas where the shape of the tissue
changes more gradually the interpolation produced by CTAn is sufficient. Generally a region of
interest was defined every 3 — 5 sections though sometimes it was necessary to draw on
consecutive sections to produce a clean shape.
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Once the region of interest is defined, save it using the Save ROI command. This allows the user
to reload the ROI and edit it if required. After saving the ROI description, save the region of
interest to a new dataset with the “Save new dataset from ROI” command. The region of interest
is now ready for viewing with Bioptonics Viewer.

Load the channels into Bioptonics Viewer. In this case the Cy3 channel has been loaded into
Red, the GFP1 channel into Blue and the GFP1 segmented heart region into Green. The first
step is to reduce the background noise on each of the channels. Select each channel in turn
using the icons on the left hand toolbar and use the minimum threshold on the opacity channel in
the transfer function editor. See 11.7g

S0808a8

SENEEERE R RDENOESE
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Blue channel with minimum threshold set to 10 to reduce background noise. Brightness has been
set to 36% and contrast to 48% to make the channel translucent:

Red channel with minimum threshold set to 50:

:

SN
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Green channel with minimum threshold set to 28:
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Red, Green and Blue channels combined:
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Produce an isosurface from the Green channel. The isosurface quality has been set to 85%,
isosurface value set to 28 and colour set to grey. The Green channel has been hidden revealing
the isosurface. If the user prefers the final image could consist of the three volume rendered
channels removing the need to produce an isosurface.

At this stage the luminance and opacity values for the blue and red channels can be adjusted to
produce the most pleasing image. In this case the red channel opacity curve has been altered.

¢ v

L

y
2 RS S

.

== _‘—

136 version 1.10.7 10/11/08



The final step is to specify a clipping plane to reveal the heart inside the specimen. Clipping plane
3 has been chosen and set to roughly the middle of the specimen. It has been set to only cut the
Red, Green and Blue channels (although the Green channel is hidden so this has no effect) and
not to cut the isosurface.
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Final image from several angles:
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The user can now decide whether to save single images using the “File > Export > Render
Image” menu option or to create a movie using the “File > Export > BMP Movie Frames” option.
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Appendix 1
Specimen Preparation

Specimens stored in PFA or other fixative should be thoroughly washed in PBS.
Specimens stored in ethanol or methanol should be rehydrated to PBS.

Embedding

Make up a 1% solution of Low Melting Point Agarose (gelling point 24-28°C) in deionised water.
40mls will be required for each 50mm x 25mm petri dish.

& Concentrations up to 1.5% agarose can be used. We would
recommend increasing the % of agarose when scanning large samples.

Cool to 60°C then filter through Whatman filter paper 113V.

Place in 32°C water bath or incubator.

When cooled to 32°C, fill deep petri dish with the agarose and place on the cold plate or ice.

If using ice it is vital that the surface is flat. Placing a glass or metal sheet on top of ice may help.

Transfer specimen(s) into petri dish with as little PBS as possible.

Place at edge of dish, using needle or forceps, gently move specimen to wash away excess PBS.
Move to centre of dish.

AFor large specimens you may prefer to rinse them in a dish of LMP
agarose before placing in embedding dish.

Monitor temperature, and when approaching gelling temperature, move specimen so that it is
suspended in the middle of agarose and is horizontal.

It is important that the specimen is placed in the centre of the petri dish, as this will simplify
trimming of the agarose block.

A It is possible, with careful positioning, to embed 2 small specimens
e.g. E11.5 mouse embryos in one petri dish.

=
Fig. A1a Side view of specimen Fig. A1b Top view of petri dish with
suspended in agarose 2 specimens embedded

Leave until agarose has completely set.
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Trimming Agarose Block

Alt is important that agarose is completely set before trimming.

Wear gloves when handling agarose blocks.

Agarose has to be trimmed into a block with the specimen in the centre.
To do this, insert a single edged blade into agarose perpendicular or parallel (depending on size
and shape) to specimen, leaving as much agarose between specimen and blade as possible.

Fig. A1lc Blade inserted

Leaving blade in position, dig out unwanted agarose between blade and side of petri dish. Any
blunt instrument can be used for this. Repeat on opposite side. Depending on position of
specimen you may have to use a scalpel blade to cut remaining two sides. On completion of this
procedure, you will have a rectangular block.

Fig. A1d Agarose block after trimming
Turn dish over and tap or prise block out.

Lay agarose block onto large petri dish lid or sheet of plastic which has been placed on top of line
template (Appendix 3).
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Fig. Ale Agarose block on template

Specimen is normally orientated so that long axis is directly above blue vertical line.

A When reconstruction is performed the transverse orientation will be
along this long axis.

When cutting the edge that will be attached to the mount, ensure that there is at least 5mm
between specimen and end of block (the distance between the red & black line).

Place end of specimen on or above red line. Trim edge of block square on horizontal black line; it
is important that this cut is completely straight. This is the edge which will be glued to the mount;
if it is at an angle it could be difficult to align specimen in scanner.

Check edge is straight by placing block on edge to be attached to mount. The specimen should
be suspended vertically in block. If not place onto template and re-trim.

Trim off excess agarose from opposite edge to face being glued, leaving a small amount of
agarose ~3mm.

Trim all other faces of block so that the size is slightly bigger than the mount.
Attaching Specimen to Mount
Wipe grooved surface of mount with methanol to ensure it is clean.

Using tissue, dry the face of agarose that will be attached to the mount.
Brush a thin layer of superglue onto mount,

A If too much superglue is used it will run down mount when block is
attached. This could result in mount being glued to work surface or fingers.

Place agarose block onto mount, with specimen centred on mount.
Press gently to remove air bubbles and ensure complete contact, hold for ~20 seconds.
Allow glue to set for 5-10 minutes.
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Fig. A1f Agarose Block Attached to Mount
Use a microtome or single-edged blade to trim agarose from four straight edges.
Start cut close to top of specimen and angle cut outwards so that it ends at the edge of mount.

Cut off the four corners at the same angle.

Fig. A1g Diagram of cuts to be made
Black lines cuts 1-4, Red lines cuts 5-8
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You should now have eight angled sides, forming an octagon shape at the top of the plug.

Fig. Alh Top view Fig. A1i Side view

Fig. A1j Trimmed Agarose Block on Mount

A Regularly check blade for glue during trimming process. Always trim
using a clean, glue-free blade.
If any of the cut surfaces have nicks or glue on them, it is advisable to re-trim
to remove damaged agarose as it may affect scanning image.
The cut edges do not have to be exactly all the same size and angle.
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Dehydration and Clearing of Specimen

Using forceps, place mount into a screw top glass bottle filled with methanol.
Change methanol until no water is remaining in agarose block. Gently swirl bottle. When no water
can be seen, change in methanol one more time.

Replace the methanol with BABB.
Bottles must be left with lids off to allow remaining methanol to evaporate

BABB Recipe

2 parts Benzyl Benzoate
1 part Benzyl Alcohol
Mix well and store at room temperature protected from light.

Specimens have to be cleared in BABB before they can be scanned. Length of time required in
BABB is dependant on size of the specimen and block. Normally specimens are left overnight to
clear. Small specimens may clear in a few hours.

For stains which are soluble in BABB e.g. X-Gal, incubation in BABB should be kept to a
minimum.

A Light sensitive specimens should be stored in dark.

&If agarose looks cloudy it has not been dehydrated properly. Return to
methanol to dehydrate.

The specimen can be scanned when it is transparent.

Specimens can be stored in BABB for a few days up to a few months, depending on stability of
stain or signal.

Cleaning Mounts

Remove agarose block.

Soak mount in methanol to remove BABB.

Ensure all glue has been removed from grooves: use scouring pad, pointed forceps or needle.
Rinse in methanol.

Air dry.

A Do not store mounts with magnetic ends touching as this can cause
the magnets to be pulled out of position
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Appendix 2

Reattaching Agarose Block to Mount

If agarose block detaches from mount, it will have to be removed and re-glued.

Use a blade to remove agarose block from mount.

You will have to re-trim if there is glue attached to the agarose block or if the cut edge is no
longer square.

Lay block on its side and cut off the minimum amount of agarose. Ensure the cut is straight;
otherwise alignment of specimen could be affected.

Dry the surface to be glued on a tissue.

Glue onto a clean mount.

A148

A It is important that the faces of block are not damaged or dusty as
this could affect quality of scanned image.
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Appendix 3

Trimming Template

\
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Place end of specimen which has to be closest to mount on or above red line.
Place long axis of specimen on blue line.
Make a vertical cut along black line. This is the face to be glued to mount.
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Appendix 4
Removing Specimen from Agarose Post-OPT

Specimens that have been OPT scanned can be removed from agarose for further analysis e.g.
H&E staining and immunohistochemistry after wax or cryosectioning.

Using a single-edged blade remove the agarose plug from the mount. Trim as much agarose
from around specimen as possible.

BABB has to be completely removed from the agarose and the specimen before rehydration.
Wash in 100% methanol, shaking gently at room temperature.
Many changes of methanol will be required.

To monitor for the presence of BABB pour methanol wash into a beaker containing water. If the
water turns cloudy, there is BABB present. Continue changing methanol until pour-off is clear in
water.

A Observe local health & safety policy when handling chemicals.
Dispose of waste chemicals according to local regulations.

Rehydrate agarose in 70%, 50%, 30% and 10% ethanol. A minimum of 60 minutes shaking
gently at room temperature in each will be required. If specimen is floating after 60 minutes,
replace ethanol and wait until it sinks. The time required for this will be dependant on size of
agarose plug.

Incubate in 0.29M sucrose for at least 60 minutes at room temperature.

At this stage any remaining excess agarose can be trimmed off.

Incubate in 0.29M sucrose pre-heated to 57°C for 30-60 minutes.

Gently shake to see if agarose has melted/fallen away from specimen. You may have to incubate
for longer (time is dependant on plug size), or increase temperature for a brief period.

If this is unsuccessful, pour sucrose and agarose plug into a petri dish.

Use fine forceps or a needle to carefully pull away agarose from specimen.

When agarose has been removed from specimen, wash a further twice in fresh 57°C sucrose.
The specimen can now be prepared for next procedure.

If long-term storage is required, place in 4% PFA or dehydrate and store in 70% ethanol.
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Appendix 5
lllumination Focusing Lens

There are three different illumination focusing lenses supplied with each scanner. One of the
three is installed in the scanner (#1). Every lens is marked by number in the holder:

Fig. ASa

Lens #1 is installed. This produces the narrowest and the strongest beam. Lens #3 produces the
widest beam and covers biggest space. Lens #2 is between these two (see Fig. A5c).

The scanner contains a high-resolution camera with a motorized zoom lens. This allows changing
image magnifications according to particular object size. Typical fields of view in minimum and
maximum zoom positions are shown by using printed mesh with 1mm pitch:

Fig. A5b

A154 version 1.10.7 10/11/08



Typical field of view in minimum zoom position is 21mm. In maximum zoom position it is 3.5mm.
The following images show what part of the same printed target will be illuminated by particular
focusing lens for the three available wavelengths of fluorescent illumination:

lllumination Focusing Lens 1:
GFP1 GFP+ CY3

GFP1

lllumination Focusing Lens 3:
GFP1 GFP+ CY3

Fig. A5c
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Appendix 6

Troubleshooting

Problem

Solution

Magnet is sitting proud or has fallen out of mount.

Do not store mounts with magnets in contact.
Tap gently with a hammer to reposition.

Can see bubbles around specimen.

Remove from BABB and pierce with needle
whilst applying gentle pressure to top of
agarose. If bubble remains return to BABB and
apply gentle pressure to expel air (the end of a
pastette is good for this).

Message “Cannot Start Camera!” when starting
the OPT Scanner is displayed.

Switch off scanner and restart computer if this
fails follow instructions in Appendix 7

No image from the camera is displayed.

Switch off scanner and restart computer if this
fails follow instructions in Appendix 7

Can’t see specimen in window.

Has live view been selected?

Has specimen been lowered to correct depth in
quartz cell?

Is exposure correct?

Is light source correct for specimen?

Can’t see fluorescent sample.

Is UV light source on?

Has correct filter been selected?

Can't see bright-field image.

Has “No filter” been selected in the “Select
filters” window?

Settings adjusted but cannot see any changes to
image.

Has live view been selected?

Check “Apply Flat-field correction” is NOT
selected.

Specimen looks opaque and “shimmers”.

Specimen not cleared properly. Return to
BABB.

There is dirt on agarose plug, which moves with
specimen when rotated.

Remove by swirling gently in BABB or gently
pipette BABB onto dirt to remove it or trim
agarose plug to remove dirt.

There are dents/holes in agarose plug.

Carefully re-trim damaged surface.

There is debris visible. It does not move when
specimen is rotated.

Remove quartz cell and wipe clear faces with
methanol-soaked dust-free tissue.

Clean white light with methanol-soaked dust-
free tissue.

There is debris visible. It moves around when
specimen is rotated.

Replace BABB in quartz cell.

Can’t align specimen.

Check specimen is positioned centrally on the
mount, if not remove agarose plug from mount
trim & re-attach. (Appendix 2)

Specimen will not complete 360 degree rotation.

The mount may have been moved so far off-
centre that it makes contact with the pusher
when rotating. Use the pusher to move the
mount back towards the centre. If still unable to
align specimen, check specimen is positioned
centrally on the mount - if not remove agarose
plug from mount, trim & re-attach. (Appendix 2)
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Problem

Solution

> >> >>> controls in Object Centering & Rotation
Window are not working or are unresponsive.

Reposition mount to the centre of the rotation
stage.

Adjust pusher offset value by increasing pusher
offset (mm) - see Appendix 10, Changing the
Pusher Offset

> >> >>> controls in Object Centering & Rotation
Window are over-responsive.

Adjust pusher offset value by decreasing
pusher offset (mm) - see Appendix 10,
Changing the Pusher Offset

Mount is moving sideways during rotation.

Ensure surfaces of mount and stage are clean,
wipe with methanol.

There are more/less than 400 tiff images in the
scan folder.

Check rot.step [deg] in scanning window is set
to 0.9

Stage squeaking when being lowered and raised.

Apply a small amount of NGL1 grade 1 or 2
grease, move stage up and down 10-15 times
to distribute grease.

The mounts are turning black in methanol.

Scrubbing with a pan scourer will remove most
of the deposit. The discolouration does not
affect scanning.
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Appendix 7
Update or Reinstall Camera Driver

You may have to perform the following procedure to reinstall or update the camera driver if:

o Bioptonics releases a new camera driver

o You see the message “Cannot Start Camera!” when starting the OPT Scanner (see
screenshot below)

o No image from the camera is displayed

BIOPTONICS Dptical Projection Tomograpy Scanner

X Cannot stait cameral
+f Fiters is Ok

&  Zoomis Dk
Init focus
Procedure

Locate the My Computer icon. This may be found on the Desktop or in the Start Menu. In either
case click on it with the Right Mouse Button and choose Properties from the context menu.
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This displays the System Properties menu. This menu can also be found through the Windows
Control Panel.

System Properties
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Choose the Hardware tab and click on the Device Manager button:

System Pre poerties
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In the Device Manager screen, locate the Imaging Devices branch and click to expand it if
necessary. Locate the Generic 1394 Desktop Camera device which may or may not have an
exclamation mark on its icon. Windows is detecting the OPT Scanner as a generic camera
instead of using the specific OPT Scanner Camera Driver. Select Generic 1394 Desktop Camera
and click the Update Driver button on the toolbar (third button from right hand side).
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The Hardware Update Wizard will be displayed. Select “No, not this time” when the wizard asks

to connect

to Windows Update. The driver required is on the computer's hard disk and is not available

through Windows update. Click Next.

Hardware Update Wizard

Welcome o the Hardware Updale
Wizard
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Choose “Install from a list or specific location (Advanced)” and click Next.

Hardware Update Wizard
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Select “Don’t search. | will choose the driver to install” and click Next.

Hardware Undate Wizard
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The following screen appears. If the driver “VDS IEEE1394 Digital Camera Interface” is listed in
the menu select it. If not, click Have Disk and on the next window choose Browse, navigate to
“C:\Program Files\Bioptonics 3001M\CameraDriver and choose the file “vds1394.inf". The driver
“VDS IEEE1394 Digital Camera Interface” should be displayed. Click to select it. If more than one
instance of “VDS IEEE1394 Digital Camera Interface” is displayed, select any one.

Click Next.
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file://localhost/Users/tccox/Tim's%20Filing%20Cabinet/MicroCT:OPT%20facility/manuals//C/C:/Program

The following window appears stating that the driver is not signed. Click “Continue Anyway”.

Hardware Installation
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The final screen appears. Double-check that the driver “VDS IEEE1394 Digital Camera Interface”
is shown on screen. Click Finish.

Hardware Update Wizard
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Appendix 8

Nvidia Graphics Driver Settings

Bioptonics Viewer uses the full capabilities of the graphics card present in the OPT Scanner
computer. For best results it requires two settings to be changed from the default settings. These
settings are made when the OPT scanner computer leaves production but they may have to be
reset after a software update.

The two settings are:
e Unified back/depth buffer set to OFF
e Maximise texture memory set to ON

To make these settings follow the following procedure:

Right click anywhere on the desktop background and choose NVIDIA Control Panel

Arrange Icors By »
Rafrash

Undo Move Cri+2

NYIDIA Control Pansd

Moo »

Propertias
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Select Manage 3D settings from the menu.
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Select the Global Settings tab

Scroll through the settings:

a Manage 3D Settings
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Set Unified back/depth buffer to Off
Set Maximise texture memory to On

Apply and close window
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Appendix 9

Consumables Order Information

Item

Quartz cell 25mmID x 1.6mm +/- 0.1mm
wall x 50mm Tall with bottom.

Mounts

Alignment Pin

XFO Lamp Unit for X-Cite

All the above items can be supplied by Bioptonics, prices on request.

Bioptonics

MRC Technology

Crewe Road South
Edinburgh

EH4 2SP

UK.

Tel: +44 (0)131 311 7029
Fax: +44 (0)131 311 7025
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Other Consumables Required

Item Information
LMP agarose Gelling Temperature 24-28°C
Petri dishes 50mm x 20.3mm, deep form

Benzyl Benzoate

Minimum 99%

Benzyl Alcohol

99% + A.C.S

Superglue

“Loctite” or similar

Microtome blade or similar

Single edge blade

Flat bottom, screw top, bottles

Minimum Height 7.5cm

Methanol

Analysis grade

Ice or coldplate

Needle or pointed forceps

Flat forceps

Whatman filter paper

113V

Glass petri dish

Stub Tweezers

Agar Scientific Cat. No T5008.
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Appendix 10

Maintenance

Breakdown Information
In the event of breakdown of the 3001M Scanner, please contact Bioptonics.
See Appendix 13 for MRCT Standard Conditions of Sale & Warranty.

Bioptonics

MRC Technology

Crewe Road South
Edinburgh

EH4 2S5P

UK.

Tel: +44 (0)131 311 7029
Fax: +44 (0)131 311 7025
Email: info@bioptonics.com
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Cleaning the Quartz Cell

The quartz cell should be cleaned before the first use of the scanner and on a regular basis.

ADirt and debris on the quartz cell can affect the quality of the scan.

Before first use:

Remove quartz cell from packaging.

Remove larger pieces of debris/packing material.

Wash thoroughly with Methanol and air dry. If necessary wipe stubborn marks with dust free
tissue.

Handle the clean quartz cell by the frosted edges.

Routine Cleaning:

To remove small marks/smears from clear sides, moisten dust-free tissue with Methanol and wipe
quartz cell.

To thoroughly clean the quartz cell, soak and rinse in Methanol. Stubborn marks may be wiped
with dust free tissue. Allow to air dry before refilling with BABB.

A Observe local health & safety policy when handling chemicals.
Dispose of waste chemicals according to local regulations.

A171 version 1.10.7 10/11/08



Replacing UV Lamp Unit

An EXFO X-Cite 120 unit is embedded in Bioptonics 3001M Scanner.
Its lamp unit has a 1500 hour lifetime.

After 1400 hours of use a message will be displayed reminding user to replace the lamp unit.
After 1500 hours of use the lamp will no longer switch on.

A When replacing lamp unit allow unit to cool down completely before
opening casing.
Protective clothing, gloves and face mask should be worn when replacing the
lamp unit.
Mains power should be disconnected before replacing lamp unit.

Disconnect power cable from mains supply.

Remove hatch at back of scanner by unscrewing 4 screws. (Fig. A9a)

Fig. A9a

A172
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View of EXFO X-cite with hatch removed
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Remove side panel of EXFO X-Cite 120 using tool provided.

Fig. A9b Lamp Housing

Lamp Unit

Lamp Bracket
Intelli-lamp Connector
Power Connector
Spring Clamp

A wbhN =

Open lamp bracket arm by pulling towards you.
Remove Intelli-lamp and power wires from grooves in lamp housing.
Disconnect 2-pin power connector from its mate on lamp housing wall.

Disconnect 4-pin Intelli-lamp sensor from its mate on lamp housing wall. To do this, press down
on catch above wires & pull out towards you.

Holding the ceramic part of the lamp module, slide lamp unit out along grooves in lamp bracket.

S Sesl

Sy L]

y \ 3\‘

A g =

T

Fig. A9c Lamp Unit
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AThe lamp unit’s operational life can be significantly shortened if
handled incorrectly. Only handle the ceramic surfaces. Do not touch bulb’s
glass envelope or the inside surface of the reflector. Skin oils can cause the

lamp to fail prematurely.

A Dispose of lamp unit according to local regulations.

Remove new lamp unit from packaging.

Hold the ceramic part of lamp with the “this side out” label towards you.

Slide the lamp unit all the way in ensuring that the leading edges of the ceramic mount are in

groves of the lamp bracket. The middle of the lamp will snap into the spring clamp.
Close the lamp bracket.
Attach 2-pin lamp power connector to its mate on lamp housing wall.

Attach 4-pin Intelli-lamp sensor connector to its mate on lamp housing wall.

A Connectors will only attach in the correct orientation. Rotate by 1800
if you are having difficulty connecting them.

Secure wires into grooves in lamp housing.

Replace side panel of EXFO X-Cite 120, secure screw.
Replace hatch on scanner by securing 4 screws.
Switch on Scanner

Open OPT scanning software

Options
Preferences

v Rascaie mage: 1o ke scosen
W Sound nothcstors

ma)e et everd

0 ‘optewel e

UV o 2000 1o~

[ ] _cme

Reset UV lamp counter.
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Changing the Focusing Lens
Three lenses (1-3) are provided with the scanner. See Appendix 5 for details.
Disconnect power cable from mains supply.

Using you&l'eft hand, pen or similar to hold open the lens cover (Fig. A9d).

Fig. A9d Lens cover held open.

Take the handle of the lens in the thumb and index finger of your right hand.

Pull the lens back very slightly (1-2mm) only gentle force is required. Push in a downward motion
away from you. See arrows in Fig. A9e. This removes the lens from the spring holder.

After removing the lens from the spring holder turn the lens 90°, to side orientation, and pass
carefully through the opening in the specimen chamber.

Care should be taken not to damage the lens on the sides of the scanner.

Fig. A9e Lens Removal
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N.B. Spring holder on left hand side is shown for illustrative purposes only as it is normally
covered. It is not necessary to remove cover to change lens.

Fig. A9f Lens holder in spring holder

N.B. For information only.
A This may take some practice.

Excessive force makes the lens impossible to remove.
Be careful not to drop the lens into the scanner, as it may damage the lens.

Installing another lens should be done in the reverse order.

Keep protective cover open with left hand.

Take the lens in your right hand, and pass through the opening in side orientation.

Turn the lens 90° so that the handle is at the top.

Push the lens forward (away from user) until past the border of the spring holder. Then move the
lens in an upward motion, inside the spring holder until you hear a loud click, which indicates the

lens is housed correctly.
A Again this may take some practice.
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Changing Pusher Offset

The pusher is the part of the scanner controlled by the Object Centering and Rotation window
which is used to centre the sample in the axis of rotation of the scanner. If the Object Centering
controls do not move the sample accurately, the pusher offset may have to be adjusted. The
pusher offset is a calibration distance set by Bioptonics before shipment and in normal use should
not have to be adjusted.

Please note: If problems with the pusher are only encountered when scanning small samples at
high magnifications check that the sample is centred with respect to the mount. If the sample has
been embedded away from the centre of the agarose plug and the agarose plug has been glued
to the centre of the mount, the pusher may not have sufficient movement to centre the sample in
the scanner. In this case, re-glue the agarose plug on to the mount taking care to centre the
sample with respect to the mount rather than centring the agarose plug with respect to the mount.

Pusher Offset Adjustment Procedure

Before beginning the pusher offset adjustment procedure please ensure the scanner alignment
procedure has been performed. The green line on the alignment window will correspond to the
axis of rotation of the stage.

The pusher is stored away from the rotation stage. When the pusher moves, its movement is
composed of two steps. An initial movement moves the pusher adjacent to the alignment pin. The
distance moved in this step is the pusher offset. The second movement moves the pusher and
the alignment pin a set distance. The distance moved depends on whether the >, >> or >>>
button was pressed. Additional presses of the >, >> or >>> buttons only moves the pusher a set
distance and not the pusher offset distance. When adjusting the pusher offset ensure that the
pusher position reset button |< is pressed after each movement. This button moves the pusher
back to its storage position. In normal use this button does not have to be pressed as the pusher
is automatically moved back to its storage position when the alignment window is closed.

Set the zoom to the mid-point.

1. Insert the alignment pin and centre it with respect to the green line on the alignment window.
This may be done by using the pusher or, if it is totally unresponsive, by using forceps and
moving the pin directly.

2. Press the pusher position reset button |<

3. Press the > button while watching the screen. The sample should move a small amount to the
right.

As the movement of the pusher happens in two parts, if the pusher offset is too large the
alignment pin will appear to move twice. In this case reduce the pusher offset by 0.1mm and
perform steps 2 and 3 again. If the pusher doesn't move enough, increase the pusher offset by
0.1mm and perform steps 2 and 3 again. If the alignment pin has moved more than a third of the
way across the screen, move it back to the centre of the screen before performing steps 2 and 3.
This is because the pusher offset value calibrated by this guide is only accurate when the
alignment pin is near the axis of rotation. If the alignment pin is to the far left of the screen the
value chosen will appear to be too large and if the alignment pin is to the far right of the screen
the value chosen will appear to be too small.

Enter new pusher offset value in Options > Scanner Setup and click OK..
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Calibrating Field of View

The field of view setting determines the pixel size in microns reported at the different zoom
positions of the scanner.

To calibrate the field of view, an object of known dimensions is placed into the scanner and
measured using the scanning software’s measuring tools. If the measured size is different to the
known dimensions, the field of view is adjusted accordingly.

Proceedure:

Start the scanner and set to minimum zoom and select high resolution. Set white light exposure
so background is white. Remove the quartz cell from the scanner. Place a specimen mount on
the floor of the specimen chamber standing upright and position it so it is below the stage and in
the centre of the white light image on the scanning software. Position the mouse at the edge of
the mount on screen and left click and drag a straight, horizontal, pink line to the other edge of
the mount. A width in microns will be reported. Note this width down. You may want to perform
this measurement a couple of times for accuracy.

=8 B - @ @ e ¢ BHe
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The specimen mounts are exactly 14mm wide: 14000um. If the measured width is not 14mm,
the field of view should be adjusted. Open Options -> Scanner Setup and note down the current
field of view.

Use the following formula to calculate the new field of view:

New FOV = Current FOV x (14000/measurement)

Replace the current field of view with the new field of view, rounded to one decimal place, in
Options -> Scanner Setup and click OK.

Measure the width of the specimen mount again and check it is now reported as 14000um.
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Appendix 11

General information on Specimens
Specimens with a diameter of 1-10mm and length of up to 15mm can be processed.

All excess membranes should be removed, as excess membranes interfere with scanning which
results in poor quality movies.

Unstained Specimens

These can be scanned to show anatomy and morphology if there is sufficient autofluorescence in
the specimen. They can be imaged using any of the fluorescent filter sets. Some tissues give
better images using certain filters — this can be ascertained using trial and error.

Coloured Specimens
DAB stained specimens should be pale brown not dark brown/black. Specimens which are too
darkly stained cannot be scanned.

NBT/BCIP staining should not be overly dark, see Fig. A10a for suitable stain intensity. Non-
specific background signal should be as low as possible. NBT/BCIP stain is soluble in BABB
which is used in OPT process; therefore very pale staining may disappear before the specimen
can be scanned.

We have found that an NBT final concentration of 10-45ug/ml is optimum for OPT. Higher
concentrations can lead to background colour developing during the scanning process. This can
result in poor quality images.

It is IMPERATIVE to wash specimen thoroughly after stopping NBT/BCIP reaction. We
recommend washing in large volumes of PBS (50mls) with agitation, for 48 hours, changing PBS
at least 4 times before fixing in 4% PFA.

Fig A10a

X-Gal staining should be relatively dark. It is very soluble in BABB (more so than NBT/BCIP),
therefore very pale staining will disappear before specimen can be scanned.

X-Gal/NBT Addition of NBT to X-Gal reaction stabilises the X-gal signal making it less soluble in
BABB. Replace iron in X-Gal stain buffer with NBT final concentration of 50-100ug/ml. For the
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best OPT results, the resulting stain intensity should be similar to that shown in Fig. A10b. Note
that addition of NBT will produce a different shade of blue to that obtained with X-Gal alone.

Fig. A10b

It is IMPERATIVE to wash specimen thoroughly after stopping X-Gal-NBT reaction. We
recommend washing in large volumes of PBS (50mls) with agitation, for 48 hours, changing PBS
at least 4 times before fixing in 4% PFA.

It is possible to scan X-Gal or NBT/BCIP-stained specimens, which have subsequently been
fluorescently labelled, but not possible to scan specimens stained with more than one visible or
coloured stain.

Fluorescent Specimens

Unless otherwise ordered at the time of manufacture, the Bioptonics OPT Scanner 3001M comes
complete with the following filter combinations:

GFP (fluorescence) — exciter 425nm/40 nm, emitter LP475 nm
GFP+ (fluorescence) — exciter 480nm/20 nm, emitter LP515 nm
Texas Red (fluorescence) — exciter 560nm/40 nm, emitter LP610 nm

OPT can be used for imaging fluorescent dyes, for example in fluorescent immunohistochemistry
or fluorescent wholemount in situ hybridisation.

Fluorescent Antibodies. Either single or double-labelled specimens can be scanned. We
currently use GFP+ and Texas Red filters for scanning signal and use the GFP filters to provide
background anatomical detail.

N.B. Cy3 fluorophore signal can bleed through into GFP+ channel; it will not be distinguishable
from signal viewed using GFP+ filter (e.g. Alexafluor 488) in section & 3D movies.

Tyramide Specimens should have as low background signal as possible. Signal may fade when
exposed to light during OPT scanning.

GFP/YFP are soluble in BABB which used in the OPT process. In order to OPT such specimens,
immunohistochemistry techniques are required.

Post-Staining

Specimens should be fixed in 4% PFA overnight. Wash well in PBS before embedding in agarose
for scanning.
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Appendix 12
Bioptonics OPT Scanner 3001M Specification

The Bioptonics OPT Scanner 3001M is to be used for research purposes only.

Physical Characteristics:
Compact desk-top scanner controlled directly from PC without using any additional interface
cards
Size: 925W x 270H x 300D
Weight: Scanner alone = approx. 30kg. Scanner + transportation box = 54kg
Power: 100-240V AC, 3A, 50-60Hz
Fuses: 5 x 20 mm T4A
Operating environment:
Operating temperature = 10-35°C
Relative humidity = 0% - 90% noncondensing
Computer connections:
Scanner control: RS232 port
Image output: IEEE1394 (FireWire)
Magnification range:
Field of view 4x4 mm....20x20mm
lllumination system:
Automatic filter changer with independent intensity control for transmission light with following
illumination options:
White (transmission) — 8 x white LEDs
Infrared (transmission) — 8 x IR LEDs
Fluorescence — Metal-halide 120W UV Source with liquid light guide:
GFP (fluorescence) — exciter 425nm/40 nm, emitter LP475 nm
GFP+ (fluorescence) — exciter 480nm/20 nm, emitter LP515 nm
Texas Red (fluorescence) — exciter 560nm/40 nm, emitter LP610 nm
Camera:
CCD-Camera with high quantum efficiency sensor operated in on-chip integration mode:
Resolution — 1024x1024 or 512x512 square pixels
Dynamic range - >63dB (>1:1500)
Exposure range — 1 ms....10sec with 1ms step
Image output — 12-bit digital with IEEE1394 (FireWire) interface
Quantum efficiency - >70%
Motorisation & object manipulator:
6-axis micro-step controller with independent microprocessor control for each motor:
Motorised zoom
Motorised focus
Motorised filter changer
Object rotation: 0.9 degree full step, 0.1125 degree micro-step
Motorised object alignment system
Motorised object positioning with 50 mm travel
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Appendix 13
MRCT Standard Conditions of Sale

1 Definition

1.1 In this Contract unless the context otherwise
requires the following terms shall have the following
meanings:
“Conditions” means these terms and conditions for
the sale of the Equipment; “Confidential
Information” means the content of the Contract
and all information of a secret, confidential or
proprietary nature (whether or not specifically
marked as such) including commercial, financial,
marketing, technical or other information, know-how,
trade secrets and other information in any form or
medium whether disclosed orally or in writing before
or after the date of the Contract, together with any
reproductions of such information in any form or
medium or any part(s) of this information;
“Contract” means the combination of Contract
Sheet, and the Schedules;
“Contract Date” the contract date stated in the
Contract Sheet;
“Contract Sheet” means the document referring to
and incorporating these Conditions;
“Currency” means the currency stated in the
Contract Sheet;
“Customer” means as defined in the Contract
Sheet;
“Customer Contact” means as defined in the
Contract Sheet;
“Customer Authorised Representative” means
as defined in the Contract Sheet;
“Defect” means a defect in the operation or
performance of the Scanner or MRCT Software
which directly results in a failure of the Scanner or
MRCT Software to operate or perform to a material
extent in accordance with the Specification and this
Contract;
“Delivery Date” is the approximate date for delivery
of the Equipment set out in the Contract Sheet
(referred to as Expected Delivery Date) as varied or
confirmed by MRCT by notice in writing;
“Equipment” means the Scanner, the Third Party
IT and the MRCT Software;
“Force Majeure” means any event outside the
reasonable control of either party including: Acts of
God, war, riot, civil insurrection, acts of terrorism,
abnormal weather conditions, malicious damage,
fire, flood, strikes, lock-outs or other industrial
action, whether of the affected party's own
employees or others, closure of or restrictions at
ports or airports; unavailability of shipping or
transport, damage to Equipment whilst in transit,
failure of supplies of power, fuel, transport,
equipment, raw materials or other equipment or
services;
“Group” means in relation to any company that
company and every other company which is from
time to time a subsidiary or holding company of that
company or a subsidiary of any such holding
company (and the terms "subsidiary" and "holding
company" shall have the meanings given to them
by Sections 736 and 736A of the Companies Act
1985);
“Incoterm” means the Incoterm set out in the
Contract Sheet;
“Intellectual Property Rights” means any patent
(pending or otherwise), copyright (including moral
rights and software), database right, design right,
registered design, trade mark or service mark

(registered or unregistered), domain name, know-
how, algorithms, processes, utility model,
unregistered design, or other industrial or intellectual
property right subsisting in any part of the world and
where relevant, any application for protection as
proprietorship for any such right;

“IT Equipment” means the equipment specifically
identified as IT equipment in the Specification;

“IT Licence” means the third party IT agreement
set out at Schedule 3 of the Contract;
“Legislation” means any applicable statute
statutory instrument, or rule, order, directive,
regulation or other instrument having force of law
(including any directive or order promulgated by any
competent supra-national body), all British,
European and international standards, and all
regulations, codes of practise, guidance notes and
other requirements of any relevant government or
governmental agency;

“Limitation Period” means thirty six calendar
months from the date of actual (or if earlier deemed)
delivery of the Equipment, but if the date of actual or
deemed delivery of the Equipment is more then 6
months after the Delivery Date then thirty six
calendar months from the Contract Date;

“Manual” means the operating manual setting out
how the Equipment should be operated and
maintained;

“MRCT” means the Medical Research Council
Technology, registered number 02698321,
registered office 1-3 Burtonhole Lane, Mill Hill,
London, NW37 1AD;

“MRCT Contact” means as defined in the Contract
Sheet;

“MRCT Authorised Representative” means as
defined in the Contract Sheet;

“MRCT Software” means any and all software
loaded onto the Third Party IT Equipment and the
Scanner by MRCT (excluding any Third Party IT
Software);

“Payment Stage” means the payment stages
defined in the Contract Sheet;

“Price” means the price for the supply of the
Equipment set out in Schedule 2;

“Scanner” means the Bioptonics Optical Projection
Tomography Scanner 3001M as defined in more
detail in the Specification, but for the avoidance of
doubt excluding the IT Equipment;

“Software” means the Third Party IT Software and
MRCT Software;

“Specification” means the description, purpose
and functional specification for the Scanner and
MRCT Software set out in Schedule 1;

“Third Party IT” means the Third Party IT
Equipment and Third Party IT Software;

“Third Party IT Equipment’” means the IT
equipment referred to in Schedule 3;

“Third Party IT Supplier’ means as detailed in
Schedule 3;

“Third Party IT Software” means any and all
software loaded onto the Third Party IT Equipment
by the Third Party IT Supplier including the software
referred to in Schedule 3;

“Trainees” means the persons listed in Schedule 4
who have been nominated by the Customer to
receive Training;

“Training” means the training to be provided by
MRCT or its subcontractors to the Operatives
referred to in Schedule 4;

“Training Period” means the period anticipated on
the Contract Date by MRCT in which the Training
will occur referred to in Schedule 4;
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“Warranty Period” means 12 calendar months
from the date of delivery or deemed delivery of the
Equipment; and

“Working Day” means a day (other than a
Saturday or Sunday) on which the banks are
ordinarily open for business in the City of London.

1.2.1 Subject to any variation in accordance with
Condition 18.4, these Conditions apply to the
supply of the Equipment, the Training and Manual
to the exclusion of all other terms and conditions
(including any terms and conditions of purchase
that the Customer purports to apply under any
purchase order, confirmation of order,
specification or other document whatsoever and
whenever).

1.2.2 The words and phrases "other", "including" and
"in particular" shall not limit the generality of any
preceding words or be construed as being limited
to the same class as any preceding words where
a wider construction is possible.

1.4 References to Conditions and Schedules are
references to the conditions contained in, and the
schedules attached to, this Contract.

2 Equipment

2.1 MRCT shall supply the Equipment, Manual and
Training in accordance with these Conditions.

2.2 The Customer shall pay the Price and any other
costs or charges due from it under the Contract,
and otherwise comply with the Contract in
accordance with these Conditions.

2.3 MRCT reserves the right without liability to the
Customer to make any changes to the Equipment
(and the Specification), Training and Manual
which are required to conform with any applicable
Legislation or which do not materially affect its
quality or performance.

24 MRCT supplies the Third Party IT to the
Customer as agent for the Third Party IT Supplier
and subject to the provisions of Schedule 3.

3  Delivery and Acceptance

3.1 The Equipment shall be delivered in accordance
with the Incoterm to the Delivery Location on or
around the Delivery Date. If there is any conflict
or ambiguity between Incoterm and the provisions
of the Contract, the Contract shall prevail. A
reasonable period in advance of the Delivery
Date to the Delivery Location the parties shall
liaise to agree detailed delivery arrangements.

3.2 The Customer shall, at its own expense, provide
all necessary assistance to enable MRCT to
apply for and secure all export, transhipment and
import clearances and licences (which MRCT is
obliged to obtain under the Contract)

3.3 MRCT is only obliged to comply with export,
transhipment and import clearances and licences,
requirements, procedures, duties, taxes and
tariffs that are reasonably expected to apply on
the Contract Date. If any such export, import or
transhipment requirements arise after the
Contract Date prior to the delivery of the
Equipment (“New Requirements”) then MRCT
shall not be liable for any delays, or additional
cost or inability to fulfil this Contract arising from
those New Requirements. MRCT shall notify the
Customer of the New Requirements within a
reasonable period of becoming aware of them
and the Customer shall then:

(a) agree to vary the Price and/or Delivery Date to
take account of the New Requirements; or

(b) terminate this Agreement, in which case any part
of the Price already paid will be refunded by
MRCT less a reasonable administration fee to
cover MRCT's irrecoverable expenses.

A185
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3.5
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The Customer is responsible for (and shall
provide at its own cost, expense and risk at the
place and time of delivery of the Equipment
adequate and appropriate equipment and trained
personnel) the safe and correct unloading and
installing the Equipment in a safe manner, in
accordance with the Training (if provided before
delivery), Manual, any requirements stated in the
Specification and any direction reasonably made
by MRCT to the Customer.

Upon delivery of the Equipment, the Customer
shall sign MRCT's delivery note or other
document presented for signature on delivery or
collection of the Equipment, and such delivery
note or other document shall be evidence that the
Equipment has been delivered.

The Customer will be deemed to have accepted
the Equipment and Manual as being in
accordance with the Contract unless the
Customer notifies MRCT in writing of any defect
or other failure of the Equipment to conform with
the Contract within 7 days of the date of delivery
of the Equipment where the defect or failure
would be apparent upon reasonable inspection
and testing of the Equipment or within a
reasonable time where the defect or failure would
not be so apparent within 7 days of the date of
delivery, failing which the Customer shall not be
entitled to reject the Equipment and MRCT shall
have no liability for such defect or failure, and the
Customer shall be bound to pay the Price as if the
Equipment had been delivered in accordance with
the Contract.

If for any reason the Customer does not accept
delivery of the Equipment, or MRCT is unable to
deliver the Equipment on time because the
Customer has not provided appropriate
information, instructions, documents, licences or
authorisation or otherwise complied with this
Contract then the Equipment will be deemed to
have been delivered, risk passing to the
Customer and MRCT may store the Equipment
until actual delivery can take place. The
Customer shall be liable for all related costs and
expenses (including without limitation storage and
insurance).

MRCT shall not be liable for any loss (including
loss of profit) costs, damages, charges or
expenses caused directly or indirectly by any
delay in delivery of the Equipment or part of it nor
will any delay entitle the Customer to terminate or
rescind the Contract.

Software

The Software will be installed on the Third Party
IT Equipment by MRCT or its sub-contractors or
the Third Party IT Supplier prior to delivery of the
Equipment.

The Third Party IT Software is provided by MRCT
as agent for the Third Party IT Supplier and is
subject to the provisions and licence terms set out
and/or referred to in Schedule 3.

MRCT grants to the Customer a non-exclusive
non-transferable licence to:

use the MRCT Software on the Equipment only
whilst the Equipment is in the

Customer’s ownership for the purposes of using
the Scanner for its intended purpose; and

make a single back-up copy of the MRCT
Software.

Except as permitted under English law the
Customer is not permitted:

to sell, transfer, rent, lease, sub-licence or loan
the MRCT Software to any third party or transfer
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(b)

(c)

(d)

5.1

5.2

5.4

5.5

6.2

(a)
(b)

6.3

(a)
(b)
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or sub-licence the Customer’s rights to the MRCT
Software set out in this Contract to any third party
(unless licence terms have been agreed by
MRCT with that third party in advance);

to copy, modify, adapt, merge, translate the
MRCT Software or any part of it or locate
derivative works based on the whole or any part
of the MRCT Software;

to reverse engineer, decompile or disassemble
the MRCT Software (except to the extent
permitted by law); and

to load the MRCT Software onto the internet or
any network or system to which access is
available to any third parties.

Customer Obligations

The Customer shall supply to MRCT all
information, instructions, documents, licences or
authorisations reasonably required by MRCT
within a reasonable time (and where such
information relates to or is required for delivery,
prior to the shipping of the Equipment).

The Customer shall (and shall procure its
employees and all persons given access of any
form to the Equipment) use, operate, and
maintain the Equipment (and comply at all times)
with:

the written instructions and guidelines contained
in the Manual;

all instruction given during the Training to the
Operatives;

all other instructions or directions issued from
time to time by MRCT;

instructions or directions issued by any applicable
regulatory or licensing authority; and

all legislation.

The Customer shall ensure its employees, agents
and sub-contractors and any person to whom it
gives access to the Equipment are adequately
trained to access, use, operate and maintain the
Equipment and any part of it.

The Customer shall satisfy itself that the persons
responsible for the use, operation, repair and
maintenance of the Equipment and every part of it
have all the information required on health and
safety relating to the Equipment contained in the
Manual, the Specification, provided in the
Training, provided in writing by MRCT, required
by any applicable health and safety regulations
and under any other applicable Legislation.

The Customer is responsible for fulfilling all
recycling obligations set out in the EC Directive
on Waste Electrical and Electronic Equipment
2003 and any subsequent Legislation to
implement that directive, at its cost.

Title & Risk

The Equipment shall be at the risk of the
Customer from the time of delivery.

Full legal, beneficial and equitable title to and
property in the Equipment shall remain vested in
MRCT until the later of:

payment in full of the Price has been received by
MRCT; and

all other money payable by the Customer to
MRCT on any other account or under the
Contract has been received by MRCT.

Until full legal, beneficial and equitable title to and
property in the Equipment passes to the
Customer then to the extent the Equipment is not
in the possession of MRCT:

the Customer shall hold the Equipment on a
fiduciary basis as MRCT 's bailee;

the Customer shall store the Equipment at its
premises in a proper manner in conditions which

(c)

6.4

6.5

6.6

7.1

7.2

7.3

7.4

7.5
7.6

7.7

(a)
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adequately protect and preserve the Equipment
and shall insure it in the joint names of the
Customer and MRCT, without any charge to
MRCT. The Customer shall not tamper with any
identification upon the Equipment (or any part of
it) or its packaging and shall ensure that the
Equipment is stored separately from any other
goods and are clearly identifiable as belonging to
MRCT. MRCT shall be entitled to examine any
such Equipment in storage at any time during
normal business hours upon giving the Customer
reasonable notice of its intention to do so; and
MRCT may at any time, on demand and without
prior notice, require the Customer to deliver the
Equipment up to MRCT and MRCT may
repossess and resell the Equipment if any of the
events specified in Condition 20 (inclusive) occurs
or if any sum due to MRCT from the Customer
under the Contract or on any other account or
under any other contract is not paid when due.
For the purposes of MRCT enforcing its rights
under this Condition 6, MRCT, its employees,
agents and sub-contractor's shall be entitled to
free and unrestricted access to the Delivery
Location and any other premises owned,
occupied or controlled by the Customer and/or
any other location where any of the Equipment is
situated at any time without prior notice.

MRCT shall be entitled to maintain any action
against the Customer for the Price
notwithstanding that legal, equitable and
beneficial title to and property in the Equipment
has not passed to the Customer.

MRCT 's rights and remedies set out in this
Condition 6 are in addition to and shall not in any
way prejudice, limit or restrict any of MRCT 's
other rights or remedies under the Contract or in
law or equity.

Prices and Payment

The Customer shall pay the Price and all other
costs or charges due from it under the Contract
without deduction or set-off against any other
account and in accordance with the terms of the
Contract.

The Price and all payments due under the
Contract shall be in the Currency.

All sums payable under the Contract are
exclusive of VAT payable upon such sums which
shall be added (if appropriate) at the rate
prevailing at the relevant date of taxation and
shall be payable by the Customer, where
appropriate, in addition when it is due to pay the
Price. Subject to Condition 3.3 the Price is
otherwise inclusive of all costs of delivering the
Equipment, and providing the Manual and
Training in accordance with the Contract.
Invoices shall be raised by MRCT in advance of
each applicable Payment Stage for the applicable
amount.

The Customer shall pay the appropriate part of
the Price on or before each Payment Stage.

No payment shall be deemed to have been
received until MRCT has received cleared funds.
If any sum due from the Customer to MRCT
under the Contract or any other contract is not
paid on or before the due date for payment then
all sums which the Customer has contracted to
pay to MRCT shall become due and payable
immediately and, without prejudice to any other
right or remedy available to MRCT, MRCT shall,
without prior notice, be entitled to:

cancel or suspend its performance of the Contract
including suspending delivery of the Equipment
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(b)

(a)

(b)

(c)
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8.3

8.4

8.5

(b)
(c)
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8.6
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and suspending the carrying out of any other
obligations under the Contract until arrangements
as to payment have been established which are
satisfactory to MRCT; and

charge the Customer interest calculated on a
daily basis on all overdue amounts (both before
and after judgement) until actual payment at the
rate of four per cent (4%) per annum above the
official dealing rate from time to time until
payment is made in full.

Quality and Warranties

Subject to the provisions of this Condition 8 and
Condition 11, MRCT warrants that:

the Scanner and the MRCT Software complies
with all material aspects of the Specification on
the date of delivery of the Equipment;

the Scanner and the MRCT Software shall
comply on the date of delivery with all applicable
Legislation directly relating to the manufacture of
equipment or software which is applicable and in
force in the UK on the Contract Date;

Training will be provided with reasonable care
and skill;

the Manual shall be compiled with reasonable
care and skill; and

it has the necessary rights to grant the licences
set out in Conditions 13 and 4.3.

The Third Party IT is provided by MRCT as agent
for the Third Party IT Supplier and therefore
MRCT has no liability whatsoever or howsoever
arising for the Third Party IT. The warranty
provided by the Third Party IT Supplier for the
Third Party IT is set out as referred to in Schedule
3.

No warranty is given that the MRCT Software is
free of all defects or errors or all viruses, or that
the MRCT Software will operate uninterrupted.

If within the Warranty Period the Customer
considers that there is Defect in respect of the
Scanner or the MRCT Software then, it shall
notify MRCT within 5 Working Days of discovery
(or when the Customer ought reasonably to have
discovered the Defect) about the alleged Defect
by giving MRCT all evidence and information in
relation to such alleged Defect. The Customer
shall ship the Equipment back to MRCT on
MRCT'’s request.

If the Customer establishes to MRCT 's
reasonable satisfaction that there is a Defect in
respect of the Scanner or the MRCT Software
which has occurred during the applicable
Warranty Period, then MRCT shall, at its
discretion:

alter any aspect of the Scanner or the MRCT
Software (as applicable); or

repair the Scanner or MRCT Software (as
applicable); or

or supply a replacement Scanner (or part of the
Scanner) or replacement MRCT Software (as
applicable); or

refund part or all of the Price.

Subject always that MRCT'’s liability under this
Condition 8.5 shall not exceed the Price.

If pursuant to Condition 8.4 MRCT is unable to
locate any Defect in the Scanner or MRCT
Software or MRCT establishes that the Defect is
caused by the Customer failing to comply with its
obligations set out in Condition 5 or MRCT
establishes that the Defect is caused by the Third
Party IT, MRCT shall be entitled to charge the
Customer for the costs and time incurred by
MRCT in investigating the alleged Defect and in
returning the Equipment (or any part thereof)

8.7

8.8

8.9

(b)
(®

(i)
(c)

(d)
(e)

®

(9)

9.2

10
10.1

10.2

10.3

11
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which the Customer has sent to MRCT. If MRCT
rejects that there has been a breach of its
warranties contained in this Condition 8, it shall
notify the Customer in writing.

Subject to the remaining provisions of this
Condition 8 (provided that the liability of MRCT
shall in no event exceed the lower of the Price
and the payments made by the Customer for the
Scanner and MRCT Software to date) fulfilment
by MRCT of Condition 8.4 in relation to a
defective Scanner and/or MRCT Software shall
constitute an entire discharge of MRCT 's liability
under this Contract for those items.

The Customer may only exercise the rights set
out in Conditions 8.4 and 8.5 within the Warranty
Period. The Warranty Period shall not be
extended as a result of MRCT taking any action
pursuant to Condition 8.5.

MRCT shall be under no liability in respect of its
warranties set out in this Condition:

in respect of any Defect in the Equipment arising
from fair wear and tear, wilful damage,
negligence, abnormal working conditions, failure
to follow MRCT's instructions (whether oral or in
writing), misuse, or alteration or repair (or attempt
to misuse, alter or repair) of any part of the
Equipment without MRCT 's written approval;

in respect of any failure of the Customer to
comply with:

MRCT's requirements for maintenance or
operation of the Equipment (including the
environment required for the Equipment) set out
in the Contract (including the Specification),
Manual, Training or any direction reasonably
made by MRCT; and/or

the Contract including Condition 5.

where there is a failure to notify MRCT of the
alleged Defect in accordance with Condition 8.4;
in relation to any type of defect, damage or wear
specifically excluded in the Specification;

if the Customer makes further use of the item
which is alleged to have the Defect after giving
notice pursuant to Condition 8.4;

where a Defect has been caused by integrating
the Equipment (or any part of it) with, or otherwise
connecting the Equipment (or any part of it) to,
any software, equipment, power source or other
technology (whether electronic or mechanical); or
if the total Price has not been paid in full by the
due date for payment.

Manual and Trainin

MRCT shall provide the Manual to the Customer
at the same time as delivery of the Equipment to
the Customer.

MRCT shall provide the Training to the
Operatives during the Training Period or such
other period which MRCT notifies to the
Customer on reasonable notice.

Contract Management

The MRCT Contact and Customer Contact are
responsible for dealing with matters relating to the
day-to-day management of the Contract, but have
no authority to vary this Contract except as
expressly stated in the Contract.

The MRCT Authorised Representative and
Customer Authorised Representative are
responsible for any variation to this Contract.
Each party may amend its respective Contacts or
Authorised Representatives by written notice
given to the other party in accordance with the
Contract.

Limitation of Liability
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(a)
(b)

(c)

The Customer acknowledges that the Equipment
is a prototype (and not a fully developed and
tested Equipment) and this is reflected in a
reduced Price. The Specification and the
Contract shall therefore be construed in that
context. The Customer acknowledges that given
the nature of the Equipment and the reduced
Price that it is reasonable for MRCT to exclude
and limit its liability in the manner set out in this
Condition 11.

Nothing in these Conditions shall exclude or limit
a party's liability for death or personal injury
arising from that party's negligence, or for
fraudulent misrepresentation.

MRCT shall not be liable for any of the following
howsoever arising:

any indirect special or consequential loss damage
or liability;

any loss, damage or liability to the extent that
such loss, damage or liability is caused by the
negligence of the Customer, its employees,
agents or contractors or by a breach by the
Customer of the Contract;

any economic loss (including loss of profit, loss of
revenue, loss of anticipated or future profit, loss of
savings or loss of business); or

any loss damage or liability incurred after the
expiry of the Limitation Period.

Subject to Condition 11.2 the total aggregate
liability of MRCT (and its employees, agents, sub-
contractors and members of its Group) arising out
of or in relation to the Contract (whether in
contract, tort, or otherwise) howsoever or
whatsoever arising shall not in any circumstances
exceed the Price.

If any such loss or damage as is referred to in
Condition 11 occurs or arises as a result wholly or
in part of the negligence or wilful misconduct or
other fault of the Customer, its servants or
agents, the amount payable by reason of MRCT's
liability to the Customer shall be reduced to such
an extent as is just and equitable having regard to
the degree to which the Customer's fault is
responsible for the loss, damage or liability in
question.

Condition 3.8 and this Condition 11 set out the
entire liability of MRCT (including any liability for
the acts or omissions of its employees, agents
sub-contractors and any member of its Group)
howsoever or whatsoever arising in respect of
any breach of these Conditions or the Contract
and any representation, statement or tortious act
or omission including negligence arising under or
in connection with the Contract.

The parties acknowledge that each of the sub
conditions in this Condition 11 are severable and
that each of those sub condition shall be
construed as separate limitations.

12 Customer's Indemnity

121

13
13.1
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In addition to any other remedy available to
MRCT, the Customer irrevocably and
unconditionally agrees to indemnify MRCT, its
employees, agents and contractors in full and on
demand from and against all claims, demands,
actions, losses, costs and expenses whatsoever
directly arising from the Customer’s breach of the
Contract.

Intellectual Property

Any and all Intellectual Property Rights of
whatever nature which do or may arise in the
Scanner, MRCT Software, Manual and Training
and their design and manufacture or as a result of
any work carried out by MRCT under the Contract

or the fulfilling by MRCT of its obligations under
the Contract shall vest exclusively in MRCT or its
licensors.

13.2  MRCT hereby grants to the Customer the non-
exclusive right and licence to use the Scanner
and MRCT Software in accordance with and for
the purposes specified within the Manual and
Specification.

13.3  Schedule 3 sets out or refers to the intellectual
property provisions applicable to the Third Party
IT.

13.4  The licences set out at Conditions 4.3, 13.2 and
13.3 shall not include the right to grant sub-
licences nor, without limitation, to carry out
research or develop or seek to develop other
products or technologies based on or derived
from or incorporating the Equipment (or any part),
Training or Manual nor any Intellectual Property
or Confidential Information of MRCT or its
licensors in any of them.

13.5 The Customer undertakes and agrees not to
modify, adapt, merge, translate, decompile,
disassemble or reverse engineer the Equipment
(or any part of it) provided under the Contract or
seek or attempt or permit or purport to permit any
third party to do so other than and to the extent
that, the same cannot be precluded by law.

14 Confidentiality

14.1  Each party shall keep and procure to be kept
confidential all Confidential Information belonging
to the other party disclosed or obtained as a
result of the relationship of the parties under the
Contract and shall not use nor disclose the same
save for the purposes of the proper performance
of the Contract or with the prior written consent of
the other party. Where disclosure is made to any
employee, consultant, sub-contractor or agent, it
shall be done subject to obligations equivalent to
those set out in these Conditions and the
Customer shall use its best endeavours to
procure that any such employee, consultant, sub-
contractor or agent complies with such
obligations. The Customer shall be responsible to
MRCT in respect of any disclosure or use of such
Confidential Information by the person to whom
disclosure is made.

14.2  The obligations of confidentiality in this Condition
14 shall not extend to any matter which a party to
whom Confidential Information has been
disclosed, and which:

(a) is in, or has become part of, the public domain
other than as a result of a breach of the
obligations of confidentiality under the Contract;
or

(b) was independently disclosed to it by a third party
entitled to disclose the same; or

(c) is required to be disclosed under any applicable
law, or by order of a court or governmental body
or authority of competent jurisdiction

14.3  On termination of the Contract (for whatever
reason) the Customer shall promptly return to
MRCT or dispose of in accordance with MRCT's
written instructions all Confidential Information
(including any copies made by the Customer)
disclosed or supplied to the Customer pursuant to
or in relation to the Contract and shall certify to
MRCT when the same has been completed.

14.4  The Customer shall not make any announcement
or otherwise publicise the existence of or disclose
to any person the terms of the Contract without
the prior written consent of MRCT.

15 Force Majeure
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15.1

15.2

15.3

If MRCT is prevented, hindered or delayed from
or in performing any of its obligations under the
Contract by an event of Force Majeure it shall
immediately notify the Customer in writing of such
matters, the date of commencement of the Force
Majeure and the effects on its ability to perform its
obligations, and shall keep the Customer fully
informed of their continuance and of any relevant
change of circumstances whilst such Force
Majeure continues.

MRCT reserves the right to suspend or cancel the
Contract in whole or in part (without liability to the
Customer) if it is prevented from or delayed in the
carrying on of its obligations under the Contract
due to Force Majeure.

If the Force Majeure continues for longer than 20
weeks the Customer may at any time whilst such
Force Majeure continues by notice in writing to
MRCT terminate the Contract subject to payment
by the Customer of the Price (or part of the Price)
for the Equipment provided under the Contract
prior to the date of such termination.

16 Termination

16.1

(a)

(c)

®
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Either party may immediately terminate the
Contract without payment of compensation or
other damages caused to the other party solely
by such termination by giving notice in writing to
the other party if any one or more of the following
events happens:

the other party commits a material breach of any
of its obligations under the Contract which, in the
reasonable opinion of the party in question (after
appropriate written notice of and consultation on
the same), is incapable of remedy;

the other party fails to remedy, where it is capable
of remedy, or persists in any breach of any of its
obligations under the Contract after having been
required in writing to remedy or desist from such
breach within a period of 20 Working Days (or
such longer period as may be agreed between
the parties as reasonable in the circumstances);
the other party proposes a voluntary arrangement
within the meaning of Section 1 or Section 253 of
the Insolvency Act 1986, or an interim order is
made under Section 252 of the Insolvency Act
1986, or any other steps are taken or negotiations
commenced or any of its creditors with a view to
proposing any kind of composition, compromise
or arrangement and any of its creditors;

the other party has any distress or execution
levied on its assets which is not paid out within
seven days of its being levied;

the other party is deemed to be unable to pay its
debts within the meaning of Section 123 of the
Insolvency Act 1986, or calls a meeting for the
purpose of passing a resolution to wind it up, or
such a resolution is passed, (or a resolution is
passed by the directors to seek a winding up or
administration order), presents, or has presented,
a petition for a winding up order, or presents, or
has presented, a petition to appoint an
administrator, or has an administrative receiver,
or receiver appointed over all or any part of its
business, undertaking, property or assets (other
than a winding up for a voluntary liquidation as
part of an amalgamation or reconstruction);

the other party stops or suspends making
payments (whether of principal or interest) with
respect to all or any class of its debts or
announces an intention to do so or suspends or
ceases or threatens to suspend or cease to carry
on its business; and

16.2

16.3

the other party supplies or undergoes any
procedure analogous to any of those specified in
Conditions 16.1(c) to (f) (inclusive) above or any
other procedure available in the country in which
the other party is constituted, established or
domiciled against or to an insolvent debtor or
available to the creditors of such a debtor.

Except pursuant to Condition 16.1 the Customer
may not in any circumstances seek to cancel or
terminate this Contract.

The termination of the Contract shall be without
prejudice to the rights and remedies of either
party which may have accrued up to the date of
termination.

17 Consequences of Termination

171

(@)

(b)

(c)

(d)

(e)

Upon termination or expiry of the Contract for any
reason whatsoever:

MRCT shall be entitled to reclaim physical
possession of the Equipment from the Customer
if termination or expiry of the Contract is before
payment of the Price in full has been made by the
Customer. The Customer hereby grants to
MRCT a licence to enter the Customer's premises
and/or the Delivery Location for this purpose.
subject to Condition 16.3 above, the relationship
of the parties shall cease and any rights or
licences granted under or pursuant to the
Contract shall cease to have effect save as (and
to the extent) expressly provided for in this
Condition 17;

the provisions of Conditions 4.4, 6, 11, 12, 13.1,
13.3, 13.5, 14, 16, 17, 18, 19, 20 and 21 and any
other provision which expressly or by implication
is intended to come into or remain in force on or
after termination shall continue in full force and
effect;

the Customer shall immediately return to MRCT
or destroy in accordance with MRCT's written
instructions all property of MRCT in its
possession at the date of termination, including all
Confidential Information and shall certify that it
has done so, and shall make no further use of
such Confidential Information; and

MRCT's shall not be obliged to continue to
perform, or commence the performance of, (as
the case may be) any outstanding work under the
Contract.

18 General

18.1

18.2

18.3

18.4

18.5

version 1.10.7

The Contract is personal to the Customer. The
Customer shall not assign, delegate, transfer,
charge, factor or otherwise dispose of all or any of
its rights and responsibilities under the Contract
without the prior written consent of MRCT (not to
be unreasonably withheld or delayed, but subject
in any event to any necessary export or other
clearances being obtained).

The obligations under, and the benefit of, the
Contract shall be freely assignable by MRCT.

No person who is not a party to the Contract shall
have the right to enforce any term of the Contract
which expressly or by implication confers a
benefit on that person without the express prior
agreement in writing of the parties which
agreement must refer to this Condition.

Any alteration or variation to the Contract shall
not come into effect unless it has been agreed
between the parties in writing and is signed by the
Customer Authorised Representative and MRCT
Authorised Representative unless expressly
stated otherwise in this Contract.

The Customer shall not exercise any right of lien,
general or otherwise and howsoever arising, over
the Equipment (or any part of it) and/or Manual in
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respect of any sums owed by MRCT to the (b)
Customer under the Contract or otherwise.

18.6  The rights and remedies of either party in respect
of the Contract shall not be diminished, waived or
extinguished by the granting of any indulgence,
forbearance or extension of time granted by such
party to the other nor by any failure of, or delay by
the said party in ascertaining or exercising any
such rights or remedies. Any waiver of any (c)
breach of the Contract shall be given in writing by

if the parties fail to resolve the dispute or claim in
accordance with the above then either party may
by notice in writing request that dispute or claim
be referred to the MRCT Authorised
Representative and the Customer Authorised
Representative who shall use reasonable
endeavours to resolve the dispute or claim within
10 Working Days of it being referred to them; and
either party may then deal with the dispute or
claim in accordance with Condition 21.2.

(in the case of MRCT) the MRCT Authorised 21 Law & Jurisdiction
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the Customer Authorised Representative. The
waiver by either party of any breach of the
Contract shall not prevent the subsequent
enforcement of that provision and shall not be 21.2
deemed to be a waiver of any subsequent breach
of that or any other provision.

18.7  The Contract is entered into in the English
language and all amendments to the Contract, all 21.3
correspondence concerning or relating to the
Contract and all notices given and all
documentation to be delivered by either party to
the other under these Conditions shall be in
writing in the English language or shall be
accompanied by an English translation prepared
by such person or body as MRCT shall have
approved in advance.

19 Notices

19.1  Any notices sent under the Contract must be in
writing and may be served by personal delivery or
by sending the notice by pre-paid airmail post (if
the Customer is located outside the UK) or
special delivery (if the Customer is located within
the UK) or facsimile transmission or e-mail to the
address given in the Contract (in the case of
MRCT the correspondence address on the front
page of this Contract) or to such other address as
the relevant party may give for the purpose of
service of notices under the Contract and every
such notice shall be deemed to have been served
upon delivery if served by hand or at the
expiration of 10 Working Days after despatch of
the same if delivered by airmail post or 3 Working
Days after despatch is delivered by special
delivery or at ten hours am local time of the
recipient on the next Working Day following
despatch if sent by facsimile transmission or e-
mail.

19.2  To prove service of any notice it shall be sufficient
to show in the case of a notice delivered by hand
that the same was duly addressed and delivered
by hand and in the case of a notice served by
post that the same was duly addressed prepaid
and posted in the manner set out above. In the
case of a notice given by facsimile transmission
or e-mail, it shall be sufficient to show that it was
despatched in a legible and complete form to the
correct telephone number (for fax) or e-mail
address (for e-mail) without any error message
provided that a confirmation copy of the
transmission or e-mail is sent to the recipient by
airmail or special delivery post in the manner set
out above. Failure to send a confirmation copy
will invalidate the service of any facsimile
transmission or e-mail.

20 Dispute Resolution Procedure

20.1  If a dispute or claim has arisen then a party shall
notify the other party in writing and the following
procedure shall apply:

(a) MRCT's Contact and the Customer Contact shall
use reasonable endeavours to resolve the dispute
or claim within 10 Working Days of that notice;
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The Contract and any dispute or claim arising out
of or in connection with it shall be governed by,
and construed in accordance with, the laws of
England.

All disputes or claims arising out of or relating to
this Agreement shall be subject to the non-
exclusive jurisdiction of the English Courts to
which the parties irrevocably submit.

The United Nations Convention on Contracts for
the International Sale of Goods 1980 (“Vienna
Convention”) shall not apply to the Contract
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